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PREFACE

Punjab School Education Board has been updating the school level syllabi
compatible with modern approach and latest research. The board has also
launched a special drive to prepare new text books as per latest national policies
inthis regard. The present book is a part of the prestigious program.

The knowledge in the subject of computer science is the need of the hour
because its study is essential for enhancement of efficient usage of science and
technology in every field of modern ere. Computerization of every department
is done to keep it updated in light of all round development of information
technology and communication. The knowledge of computer education is
necessary for everyone to avail the latest information about different
departments, e-ticketing and usage of internet.

Keeping in view of these requirements Punjab School Education Board
has introduced computer science as a compulsory subject at Secondary and
Senior Secondary levels as per guidelines of Punjab Government. This subject
is already taught by PICTES in Government Schools. Every effort has been
made to include each requisite information regarding the subject in this book. I
hope it will be useful for students and teachers.

All suggestions for the improvement of the book will be highly
appreciated.

Chairman
Punjab School Education Board
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Chapter

1 OFFICE TOOLS

Objectives of this chapter:

Introduction

1.1 Introduction to office tools

1.2 Using MS-Word

1.3 MS-Excel

1.4 Using mail merge with spreadsheet
1.5 Page Layouts

1.6 Finalizing a Document

1.7 Print Preview

1.8 Print Command

1.9 MS-Power-point

1.10 Saving Presentation

Introduction:

1.1

As we all know that hardware and software work together to
accomplish a task. Computer software is classified into two broad
categories: system software and application software.

System Software: System software consists of a group of
programs that control the operations of a computer equipment including
functions like managing memory, managing peripherals, loading,
storing, and is an interface between the application programs and the
computer. MS DOS (Microsoft Disk Operating System), UNIX are
examples of system software.

Application software: Software that can perform a specific task
for the user, such as word processing, accounting, budgeting or payroll,
fall under the category of application software.

Introduction to office tools:

Office tools are software programs designed to make computer users
more productive and efficient at their workplace. Office productivity
tools range from word processing to spreadsheet, presentation and
database etc.

Office Productivity tool is a category of application programs that
help users produce things such as documents, databases, graphs,
worksheets and presentations. Many productivity applications are
intended for business use. Examples of office productivity software
include word processors, database management systems, graphics
softwares and spreadsheet applications.
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1.1.1 Types of office tools are:

e Word processing tool: The main purpose of this tool is to produce
documents. MS-Word, Word Pad, Notepad and some other text editors
are some of the examples of word processing tools.

e Database software tool: Database is a collection of related data. The
purpose of this tool is to organize and manage data. The advantage of
this tool is that you can change the way data is stored and displayed. MS
access, dBase, FoxPro, Paradox, and Oracle are some of the examples of
database software.

e Spread sheet tool: The spread sheet tool is used to maintain budget,
financial statements, and sales records. The purpose of this tool is
organizing numbers. It also allows the users to perform simple or
complex calculations on the numbers. MS-Excel is one of the examples
of spreadsheet tools.

e Presentation tool: This tool is used to display the information in the
form of slide show. The three main functions of presentation tool is
editing that allows insertion and formatting of text, including graphics
in the text and executing the slide shows. The best example for this type
of tool is Microsoft PowerPoint.

e Multimedia software: Media players and real players are the examples
of multimedia tool. This tool allows the user to create audio and videos.
The different forms of multimedia tools are audio converters, players,
burners, video encoders and decoders.

Note:

Productivity tools are increasingly available for mobile devices also.
However, mobile productivity apps are generally for basic tasks like
e-mail, note-taking and calendar functions, rather than more
substantial tasks, such as word processing.

1.2 Using MS Word:

In previous classes we already have studied about various features of MS
word such as creating, editing and formatting a document, inserting tables,
pictures and editing them. We have also used the feature of mail merge, spell-
check and thesaurus etc.

Microsoft Word can be used for the following purposes:

° To create business documents having various graphics including
pictures, charts, and diagrams.

o To store and reuse readymade content and formatted elements such as
cover pages and sidebars.

0 To create letters and letterheads for personal and business purpose.
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° To design different documents such as resumes or invitation cards etc.

° To create a range of correspondence from a simple office memo to legal
copies and reference documents.

Formatting in MS - Word:

Here we will learn more about word in different manner. Before using

word tool we must define and plan a document design. Planning a
document design is vital to ensure the printed output of our document
accomplishes our goal or not. Document design determine if the
document orientation will be portrait (vertical) or landscape (horizontal),
if the document will be formatted in single or multiple columns. A
landscape document with two columns is the most readable and popular
layout for an event program. It also determines if we will use any images
or clip art.

1.2.1 Templates in Microsoft Word:
Word 2010 allows us to apply in-built templates from a wide selection of
popular Word templates, including resumes, agendas, business cards,
and faxes.

Fig: 1.1

To apply a template in Word, do the following;:
1. On the File tab, click New.
2. Under Available Templates, select of the following:
e To use one of the in-built templates: Click Sample Templates click the
template that we want, and then click Create.
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e To reuse a template that we've recently used: Click Recent Templates,
click the template that we want, and then click Create.

e To find a template on Office.com: under Office.com Templates, click the
template category that we want, click the template that we want, and
click download to download the template from Office.com to our
computer.

3. Once we have selected our template we can modify it in any way to create
the document we want.

Microsoft Word 2010 allows us to create and edit personal and business
documents, such as letters, reports, invoices, emails and books. By default,
documents saved in Word 2010 are saved with the .docx extension.

~ Here are some Quick Tips:

1. Decide what we want to accomplish with our document.

2. Identify our users.

3. Identify the layout and design, file, format, and storage location.

1.2.1.1 Creating a resume with MS - Word templates
So far we have learnt about many features of MS —Word. Here we will
create a resume with MS —Word. Follow the steps written below:
1. Click on New option in File tab.

Fig: 1.2
2. In office.com templates, select Resumes and Cover Letters.
3. MS - Word will download the selected template from office.com
templates.
4. Here various styles are available for Resumes
and Cover Letters. Select any one according to
the requirement and click Download.

5. Resume with selected template will appear. Fig: 1.3
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Fig: 1.5

Fig: 1.4

6. Now we can edit it and can make the necessary changes in resume.
7. After filling all the required information in the resume, save it.

1.3 MS-Excel:

Like MS — Word we have already learnt so much about MS - Excel. We
have used Excel for creating worksheets, tables, results, doing mathematical
calculations and representing data in pictorial view with the help of charts.
Excel is a spreadsheet program used to create and format workbooks. It helps
us in analyzing data and making data more informative in order to take
business decisions. Specifically, we can use Excel to track data, analyze data,
write formulas to perform calculations on that data, pivot the data in
numerous ways, and present data in a variety of professional looking charts.

As in MS - Word we have used templates to create resume, here we will
learn about using templates in MS -Excel. Excel allows us to create a new
workbook using a template, which is a predesigned spreadsheet. Several
templates are preloaded in Excel, while others can be located on Office.com. A
spreadsheet template is a predesigned spreadsheet which we can use to create
new spreadsheets with the same formatting and predefined formulas. With
templates, we don't need to know how to do the maths or even how to write
formulas—these are already integrated into the spreadsheet.

1. Click the File tab and Select New. The Available Templates
pane appears.

2. In Available templates, click Sample templates to choose a
in-built template, or select an Office.com template category to




download a template

1.3.1Create a workbook using a template:
User can select the template according to the requirement. Here we will

take different examples.
1.3.1.1 Sales invoice

In the similar way can use Sales invoice under Invoices. We can edit this
invoice and enter data in this invoice to make calculations according to our
requirement.

This invoice can be saved as a new workbook. We can place our company
logo and edit date and invoice no. and other details in the invoice also. After
entering the required data in this invoice it will calculate the total in Balance

due cell.

Fig: 1.6




1.4 Using mail merge with spreadsheet
As we have learnt many things about Word and Excel, let us try to do

something new with these two tools.

1.4.1 Creating Student Annual Report
1. First of all, we should prepare the Annual report Format in Ms word.
Here, in this we have mentioned student's detail like admission no, roll

no, name, father's name, marks of each subject, overall result and
percentage of marks of student.

Fig: 1.7
2. On the other side, we have prepared an excel worksheet, in which
student's admission no, roll no, name, father's name, subject-wise
marks obtained in Punjabi, English, Maths, Science, Sst, and grades of
EVS and Computer are filled.

Fig: 1.9




e Here we calculate the total marks using Autosum function ¢ of MS
excel.

Fig: 1.9

e Next we calculate the percentage of marks of each student using a
formula (=L3*100/450).

Fig: 1.10
e Next field shows the result of each student.

Fig: 1.11
® Now save this Excel sheet and continue in Ms-Word , where we have
prepared the Student Annual Report.

3. Now, click on Mailings Tab, and start mail merge. Then, choose Letter
option which we have already prepared.
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4.

Fig: 1.12

Next Click on Select Receipients and select Use Existing List option. Choose
excel Sheet1$ from Select Table dialog box and click OK.

Fig: 1.13

Fig: 1.14

We should place our cursor where we want to insert the value of field from
excel sheet. Now go to Insert Merge Field option in Write & Insert Fields

group. A drop down menu will be displayed having field names according
to excel worksheet we have selected




Fig: 1.15

Select the field names one by one after placing the cursor in proper

place in the student annual report. All fields will be displayed as
shown in figure below:

Fig: 1.16

After inserting all the fields we can preview the result of students by
clicking Preview Results option. We can also preview the result of

next and previous student, first and last student using navigation
button

10




Fig: 1.17
8.  Now click on Finish & Merge option and select Edit Individual
Documents from the menu. A dialog box Merge to New Document

will open. Choose option All and click Ok to show the report card of
all the students in excel worksheet.

Fig: 1.18 Fig: 1.19

Now a new Word document will open having Report card of all the

students as shown in figure below. We can save this document and can also
take printouts.

9.

Fig: 1.20
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1.5 Page Layouts:
1.5.1 Adjusting Line Spacing:

The default spacing is 1.15 line spacing and 10
points after each paragraph. The easiest way to change
the line spacing for an entire document is to select the
paragraphs or entire document that we want to change
the line spacing on.

1. On the Home tab, in the Paragraph group, click

Line Spacing.

2. Do one of the following as shown in fig 1.22:

Click the number of line spaces that we want. For
example, click 1.0 to single-space with the spacing that is
used in earlier versions of Word. Click 2.0 to double-space
the selected paragraph. Click 1.15 to single-space with
the spacing that is used in Word 2010.

Fig: 1.21

3. Click Remove Space Before Paragraph to remove any additional lines

added after each paragraph as a default
Note:

amount of spacing.

If a line contains a large text character, graphic, or formula, Word increases
the spacing for that line. To space all lines evenly within a paragraph, use
exact spacing and specify an amount of space that is large enough to fit the
largest character or graphic in the line. If items appear cut off, increase the

1.5.2Page Margins:

Page margins are the blank space around the edges of
the page. In general, we insert text and graphics in the
printable area inside the margins. When we change a
document's page margins, we change where text and

graphics appear on each page.

1.5.2.1 Setting Predefined Page Margins:

1. On the Page Layout tab, in the Page Setup

group, click Margins. The Margins gallery drop down

menu will appear.

2. Click the margin type that we

want to apply.

Fig: 1.22
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1.5.3 Page Orientation:

We can choose either portrait (vertical) or landscape (horizontal)
orientation for all or part of our document.
1.5.3.1 To change Page Orientation:

e On the Page Layout tab, in the Page Setup group, click Orientation.

e Click Portrait or Landscape.
1.5.3.2 Different Page Orientations on Same Document:

1. Select the pages or paragraphs that we want to change to portrait or

landscape orientation.
2. On the Page Layout tab, in the Page Setup group, click Margins.
a. Click Custom Margins at the bottom of the drop down menu.
b. A Page Setup dialog box will appear.
c. On the Margins tab, click Portrait or Landscape.
d. In the Apply to list, click Selected text or This point forward.

Note:

If we select some but not all of the text on a page to change to portrait or
landscape orientation, Word places the selected text on its own page, and
the surrounding text on separate pages.

1.5.4 Creating Custom Margins:
1 On the Page Layout tab, in the

Page Setup group, click

Margins.
2. At the bottom of the Margins

gallery drop down menu, click

Custom Margins.
3. The Page Setup dialog box will

appear.
4. Enter new values for the

margins in all or some of the Fig: 1.24

Top, Bottom, Left or Right text boxes.
5. Click OK.

Note:

Most printers require a minimum width for margin settings, because
they can't print all the way to the edge of the page. If we try to set
margins that are too narrow, Microsoft Word displays the message One
or more margins are set outside the printable area of the page.
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1.5.5 Page Breaks:

Word automatically inserts a page break when
we reach the end of a page. If we want the page to break
in a different place, we can insert a manual page
break.

1.5.5.1 Inserting a Page Break:
1. Click where we want to start a new page.
2. On the Insert tab, in the Pages group, click Page Break.

Note:

We can also insert breaks into our document by going to the Insert
tab, Pages group and clicking on the Page Breaks command to view a
variety of page and section breaks you can insert into your document.

Fig: 1.25

One another formatting option is setting Tab stops.

1.5.6 Tab Stops:

Creating tab stops can be helpful when creating a large number of
documents such as flyers, table of contents or even when creating a resume. They
help us to display and line up information correctly.

1.5.6.1 Setting Manual Tab Stops:
1. Click the tab selector at the left end of the ruler |[£)| until it displays the
type of tab that you want.
2. Then click in the ruler at the top of our page, where we want to set the
tab stop.
The different types of tab stops are
- [L] A Left Tab stop sets the start position of text that will then run to
the right as we type.
[£] A Center Tab stop sets the position of the middle of the text. The
text centers on this position as we type.
[a] A Right Tab stop sets the right end of the text. As we type, the text
moves to the left.
=] A Decimal Tab stop aligns numbers around a decimal point.
Independent of the number of digits, the decimal point will be in
the same position. (We can align numbers around a decimal
character only)
[+] A Bar Tab stop doesn't position text. It inserts a vertical bar at the

tab position.

Note:

We can drag existing tab stops left or right along the ruler to a different
position. Just Click and hold on the tab stop on the ruler then drag it to
where ever we would like it to be.

14




1.5.7 Clear Tab Stops
1. We can clear tab stops in a variety of ways, the simplest is going to the ruler,
click and hold on the tab stop and drag in down towards the document. The
tab stop will disappear. To quickly clear multiple tab stops and start fresh:

a.
b.

€.

Click the Home tab; click the Paragraph Dialog Box Launcher.
A Paragraph box will appear, click on the Tabs button at the
bottom left of the dialog box.

c. A Tabs dialog box will appear.
d.

In the list under Tab stop position, click the tab stop position that we
want to clear, and then click Clear. To remove the spacing from all
manual tab stops, click Clear All.

Click OK.

1.6 Finalizing a Document:

After completing our work, we need to finalize our document using

some features of MS-word.

1.6.1 Using the "Spell Check" Feature:
As we type our document, red wavy lines will appear under any word that is
spelled incorrectly. The fastest way to fix spelling errors is to:

1.
2.
3.

Put our cursor over the misspelled word and right click.

A drop down box will appear with correct spellings of the word.
Highlight and left click the word we want to replace the incorrect
word with.

To complete a more comprehensive Spelling and Grammar check, we

0N =

can use the Spelling and Grammar feature.

Click on the Review tab.

Click on the Spelling & Grammar command

A Spelling and Grammar box will appear.

We can correct any Spelling or Grammar issue within the box.

Fig: 1.26
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1.7 Print Preview:
Print Preview automatically displays when we click on the Print tab. When
we make a change to a print-related setting, the preview is automatically updated.
To print preview of our document follow these steps:
1. Click the File tab, and then click Print. To go back to our document,
click the File tab.
2. A preview of our document automatically appears. To view each page,
click the arrows below the preview.

1.8 Print Command:
The Print tab is the place to go to make sure we are printing what we want.

1. Click the File tab.

2. Click the Print command to print a document.

3. Click the Print button to print our document.

4. This dropdown shows the currently selected printer. Clicking the

dropdown will display other available printers.

5. These dropdown menus show currently selected Settings. Rather than
just showing us the name of a feature, these dropdown menus show us what the
status of a feature is and describes it. This can help us figure out if we want to
change the setting from what we have.

Fig: 1.27
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1.6 MS - Power Point:

Microsoft PowerPoint is a presentation tool that supports text, shapes,
graphics, pictures and multimedia along with integration with other Microsoft
Office tools like Excel. By default, documents saved in PowerPoint 2010 are
saved with the .pptx extension whereas; the file extension of the prior
PowerPoint versions is .ppt. PowerPoint enables us to present information in
office meetings, lectures and seminars to create maximum impact in a
minimal amount of time.

1.6.1 Background in MS - Power Point:

We all know that PowerPoint is a design-based program. Backgrounds in
Power point are effective ways of improving the readability of the slides. The
Themes in PowerPoint help us to select the backgrounds by default, so every
time we change the theme, the default background is set automatically. Theme
includes more than just backgrounds.

Fig.1.28
A theme is a set of colors, fonts, effects, and more that can be applied to
our entire presentation to give it a consistent, professional look. We can apply
any theme by clicking it in the Design ribbon.
Here are the steps to apply backgrounds in PowerPoint.

1. In the Design ribbon, under the Background group, click the

Background Styles command.
2.  Select one of the background styles that suit our requirements.

Fig: 1.29
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1.  To edit the background for a specific slide, right-click on the desired
background slide and select "Apply to Selected Slides".
2. Selected slide(s) now have the new background.

Note:

The graphics in the slide background can
distract us from the actual content, in such
cases we can hide the graphics and retain a plain
background till we finish working on the
content. To do this, select the slide and check the
"Hide Background Graphics" checkbox.

Fig.1.30

1.9.2 Transitions in MS - Power Point:
PowerPoint supports slide transition feature which allows us to specify

how the slides should transition during the slide show.
PowerPoint presentation that had special effects between each slide, are

slide transitions. A transition can be as simple as fading to the next slide or as
complex as a flashy effect. This means we can choose transitions to fit the style
of any presentation. There are three categories of unique transitions to choose
from, all of which can be found on the Transitions tab:

e Subtle (slight transitions)

Fig: 1.31

e Exciting (strong transitions)

Fig: 1.32
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®- Dynamic Content (strong transitions that affect only the content,
such as text or images)

Fig: 1.33

The steps to add and preview slide transitions are:

1. Select the slide to which we want to apply the transition.

2. Goto the Transition Scheme under the Transitions ribbon.

3. Select one of the transition schemes from the list available.
PowerPoint will instantly show us a preview of the scheme. If we are
not satisfied, we can pick an alternate scheme. The last selected
scheme will apply to the slide.

4. We can change the effects on the selected transition scheme from the
Effect Options menu. Every scheme has a unique set of effect options.

Fig.1.34
5. We can also modify the transition timing settings from the Timing
section.
6. To preview the slide transition, click on Preview.

1.9.3 Animation in MS - Power Point:
Animation can help us to make PowerPoint presentation more dynamic,

and information more memorable. The most common types of animation
effects include entrances and exits. We can also add sound to increase the
intensity of our animation effects. To add animation to text or an object apply

following steps:
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1. Select the text or object that we want to animate.
2. On the Animations tab, in the Animation group, click an animation

effect from the gallery or click the more arrows to see more options.

Fig: 1.35

In the gallery, entrance effects icons are colored green,

emphasis effects icons are colored yellow, and exit effects
icons are colored red.

3. To alter how our selected text animates, click
Effect Options and then click what we want the
animation to do

Note:

Not all animation effects offer the same Effect
Options choices.

4. To specify the timing of the effects, on the
Animations tab, use the commands in the Timing group.

Fig: 1.36
1.10 Saving Presentation:

Save option allows us to save a new file or an existing file in standard
format (.pptx format). If we are working on a previously saved file this will
save the new changes in the same file format. If we are working on a new file,
this command would be similar to the Save As command.

1.10.1 Saving Presentation as pdf file:

As we know PowerPoint is used to create presentations, it supports
various file types when it comes to saving the content. Using a pdffile type can
be a great way of saving the slides.

20




Steps to save a presentation as a pdffile are:

1. Goto File tab.

2. Click on Save As to open the Save As dialog.

3.  Add aproper name to the file.

4. Select the file type as .pdf from the list of supported file
types and click save.

5.  The .pdffileis created in the specified location.
1.10.2 Saving Presentation as video file:

PowerPoint allows presentations to be saved as files that can be posted
on video sharing platform like YouTube or just played on any other media.

Steps to save a presentation as a video file are:

1. Go to File tab.

2. Click on Save As to open the Save As dialog.

3. Add a proper name to the file.

4. Select the file type as .wmv from the list of supported file
types and click Save.

5. The video creation is not an instant process like other file types
as PowerPoint needs to create the video file. We can track the
progress of video creation at the bottom of our presentation
window.

6. Once the creation is complete, the video file is created in the

specified location.
1.10.3 Image File:

Among the many file types that PowerPoint supports Image File is also
supported by it. There are a set of extensions for image files. The image file
extensions supported by PowerPoint include JPEG (.jpg), GIF (.gif), TIFF
(.tiff) and Bitmap (.bmp).

1.10.4 PPT *Printing Presentation:

It is sometimes necessary that we share our slides with our audience
in printed format before we begin presenting them so they can take notes.
1.10.5 PPT *Broadcast Slideshow:

PowerPoint 2010 offers users to broadcast their presentations on the
internet to worldwide audience. Microsoft offers the free broadcast Slide
Show service; all we need to do is share the link with our audience and they
can watch the presentation from anywhere. There is no special setup or
charges required to do this; all we need is a Windows Live account.

1.10.6 PPT *Packaging Presentation:

Certain presentations are better suited for distribution as a CD to
audience. In such cases, we can create a CD packaging which can be burned
into a CD and distributed.

21




oints emember

10.

11.

12.

13.
14.

15.

16.

17.

18.

19.

20.

21.

22.

Computer software is classified into two categories: system software
and application software.

System software is software that consists of a group of programs.
Application software is software that can perform a specific task for the
user.

The main purpose of Word processing tool is to produce documents.
Database software is a collection of related data. The purpose of this
tool is to organize and manage data.

The spread sheet tool is used to maintain budget, financial statements,
and sales records.

Presentation tool is used to display the information in the form of slide
show.

Multimedia software is tool that allows the user to create audio and
videos with the help of Media players and real players.

We can choose either portrait (vertical) or landscape (horizontal)
orientation for all or part of our document.

Word automatically inserts a page break when we reach the end of a
page.

We can drag existing tab stops left or right along the ruler to a different
position.

As we type our document, red wavy lines will appear under any word
that is spelled incorrectly.

Print Preview automatically displays when we click on the Print tab.
Microsoft PowerPoint is a presentation tool that supports text, shapes,
graphics, pictures and multimedia.

The Themes in PowerPoint helps us to select the backgrounds by
default.

A transition can be as simple as fading to the next slide or as complex
as a flashy, eye-catching effect.

There are three categories of unique transitions to choose from, all of
which can be found on the Transitions tab: Subtle (slight transitions),
Exciting (strong transitions), Dynamic Content.

The most common types of animation effects include entrances and
exits.

We can also add sound to increase the intensity of our animation
effects.

In the power point gallery, entrance effects icons are colored green,
emphasis effects icons are colored yellow, and exit effects icons are
colored red.

We can press the Esc key at the top left of our keyboard to stop or end
the slide show in power point.

PowerPoint allows presentations to be saved as files that can be posted
on video sharing platform like YouTube or just played on any other
media.
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Exercise

1. Multiple Choice Questions:

1.

Which tool is used to maintain budget,
financial statements, and sales records?

a) Multimedia b) Spread sheet

c) Presentation d) Database
Word automatically inserts a page break
when we reach the of a page.
a) Starting b) End
c) Mid of page  d) None of these
As we type our document, wavy
lines will appear under any word that is

spelled incorrectly.

a) Blue b) White

c) Red d) Black

The most common types of
effectsinclude entrances and exits.
a) Animation b) Sound Effect
c) Design d) Transition
Page are the blank space around
the edges of the page.

a) Graphics b) Design

c) Margin d) None of these

Fill in the Blanks:

Computer software is classified into two
categories:

We can choose either .......ccccovivvieeeeeeeennnnnn.
(vertical) or (horizontal)
orientation for all or part of our document.
The image file extensions supported by
PowerPoint include ......cccceeeeeeeveeeeeneennnnn. .a.,
................... , TIFF (.tiff) and Bitmap (.bmp)
Multimedia software is tool that allows the
user to create............... and with
the help of Media players and real players.

True or False:

The main purpose of Spread sheet software is
to produce documents.
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Application software is software that can
perform a specific task for the user.

We can drag existing tab stops left or right
alongtherulerto adifferent position.

Print Preview automatically displays when we
clickonthe Printtab.

Very Short Answer type Questions:

Write extension of Word document in Ms
Office 2010.

Write extension of Spread Sheet in Ms Office
2010.

Write extension of Power Point Presentation
Ms Office 2010.

Write the full form of bmp (Image file)
Write the full form of PDF.

Short Answer type Questions:

Define System Software?

Explain Database software?

Explain Multimedia software

What is Page Break? How to Insert a Page
Break?

Long Answer type Questions:

What is office tool? Explain any five types of
office tools?

Write steps to create Student Annual Report
using mail merge with spreadsheet?

What is Tab Stops? Explain Setting Manual Tab
Stops

Explain Print Preview and Print Command?
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Spread sheet

End
Red

Animation

Margin

Answers Key

Multiple Choice Fill in the Blanks Very Short Answer

System software and

application software
Organize and manage TRUE Xlsx
Portrait or landscape TRUE pptx
JPEG (jpg), GIF (.gif) TRUE Bitmap

Portable Document

Audio and videos
Format
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Chapter HTML
2 HTML FUNDAMENTALS (<>

Objectives of this chapter:

Introduction

2.1 Introduction
What is HTML?
Basic structure of an HTML document
CREATING AN HTML DOCUMENT
Web Browsers
HTML TAGS
Attributes
Body tag with attributes
Formatting in HTML document
Lists
Images
Tables

— == OO0 O WIN

N~ O

2.1 Introduction

The Internet is rapidly becoming a key resource for locating information
relevant to a particular field. The Internet has been called the "network of
networks." Simply put, it's a way to link millions of people around the world,
each of whom is using a computer, smart phone, tab etc. connected to a smaller
network through ISP. Nobody owns or controls the Internet or the World Wide
Web, although millions of individuals and organizations control their own
systems. Some task forces have been constituted for its smooth functioning.
WWW is composed of millions of webpages containing text, graphics, sounds,
videos and link to other webpages. Have you ever think which basic technology
lies in writing these webpages, which we are using daily? We need a computer
language to design these web pages. The Basic and frequently used language
for designing a webpage is HTML. In this chapter we will discuss the basics of
HTML.

2.2 What is HTML?

HTML stands for Hyper Text Markup Language. HTML is a language
used for DESIGNING A WEB page in which text, graphics, and other
information are organized, formatted, and linked together. HTML is a tag based
Language, which specifies the web browser what operation has to be
performed on the given text. Hypertext refers to a text which acts as a link in
markup language for describing web documents (web pages).A markup
language is a set of markup tags, HTML documents are described by HTML
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tags, Each HTML tag describes a distinct meaning for which it has been
designed.

HTML is extremely simple, Flexible, easy to learn, interactive, widely
accepted Markup Language.

2.3 Basic structure of an HTML document
An HTML document has two main parts:

e Head. The head section contains title that identifies the heading of
the HTML document.

e Body. The body element contains the actual contents or information
that you want to display on a web page to the end user.

— HTML document contains the following syntax:-

<html>

<head>

<title>TITLE OF YOUR WEBPAGE </ title>
</head>

<body>

Information which user wants to show.
</body>

</html>

Fig: 2.1
The tags defined in the above structure basically define or instruct the web
browser about the different operation to be performed on the text defined
in the given TAGS. We will now explain the above structure.

1.3.1 <HTML>HTML document is started with <html> and ended
with</html>with this tag. This TAG informs the web browser
from where a web page will start and where it ends. If the
commands are not defined in tags then the commands are taken

as text by the web browser.
1.3.2<HEAD Tag> Head tag provides Header information. The

document title is written in Head Tag. It always occurs in pair.
Head Tag is considered very important for a web page. This is a
container tag. It defines the Heading of the HTML document. It
starts with<HEAD> TAG and ends with </HEAD> .This Tag is
always defined below <HTML> and above <BODY>tag. It
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contains information regarding title of the webpage, keywords

used by the search engines etc. It contains no text in itself.
Eg. <HEAD> <TITLE> First Web Page </TITLE></HEAD>
2.3.3<TITLE>TITLE tag defines the title of the webpage, which is to be

displayed on the title bar of the web browser when the web page is
loaded in the web browser. It is enclosed in between <TITLE>
AND</TITLE>tags. It should be short and meaningful of <TITLE>

First Web Page </TITLE>
2.3.4<BODY>BODY tag contains the actual information to be displayed

on the web browser. When the webpage is loaded in the web
browser. It may contain any element or contents related to text,
images, audio, video etc. These contents are defined with in
<BODY> and </BODY> tags. e.g. <BODY>This is my first

document in HTML document. </BODY>
Each Body tag has different characteristics. These characteristics

(properties) are termed as attributes. We can select Background colour, text
colour, font size etc. with these attributes.

2.4 CREATING AN HTML DOCUMENT:-
HTML webpages are plain text files that can be created using any text

editor or word processor such as Notepad, WordPad, MS-word. The following
steps are to be taken while creating and displaying a webpage.

1. Open Notepad by clicking Start-All Programs—Accessories—Notepad

or by typing Notepad in the run window. Notepad will be opened asshown
infig.2.1

Fig: 2.2
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2. Now type the html code in the Notepad as Shown in the Fig. 2.2
Click on File— Save menu option. A dialog box will appear as shown fig 2.2

select where we want to save the file, enter file name with an
extension .html

Fig: 2.3

2.4.1 VIEWING AN HTML DOCUMENT:-

Any HTML document can be viewed using any web browser like Internet

Explorer, Netscape Navigator, Mozilla Firefox, Opera or Google Chrome. Here
Internet explorer is used in examples.

To open Internet Explorer follow the underwritten steps:

1. Start— All Programs — Internet Explorer or start -+ Run — explore

in the text box and click OK.

2. Click File—Open or press Ctrl + O from the keyboard, an open box
will appear and select html file as shown in fig 2.3
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3.

Fig: 2.4

Choose the path where file is stored and open it with open button. The
webpage will be displayed in the browser as shown in fig 2.4:-

Fig: 2.5
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2.5 Web Browsers:-

Web browser is a software which is used to browse web pages. Some of
commonly used web browses are :-

1. Internet Explorer 2. Google Chrome

3. Mozilla Firefox 4. Opera
2.6 HTML TAGS

As to attract end users we have to make our web page attractive, which may
include text , graphics, and links. In HTML we can use tags which are defined in angle
brackets<>. The use of less-than and greater-than angle brackets surrounding an
element creates what is known as a tag. Tags most commonly occur in pairs of opening
and closing tags.

These tags are also known as elements. These tags can be defined in
two forms these are:-

1. Container Tags.

2. Empty Tags.

1 Container Tags:-The container is an area enclosed by the Opening and
closing tags. Container tags come in pairs. Every tag which is opened must be closed.
A container tag consists of a start tag and end tag, with the content inserted in
between, for example: <tag name>content goes here...</tag name>

for example, when you want italic text, you will contain the text between
opening <i>and closing </ i>. Html encloses the entire document in <html> and
</html>.

2 Empty Tags:-These elements are called empty or void and they only have a
start tag as they don't have any content. They must not have an ending tag in HTML.
For Example <BR> tag is used to break the given line from where it is used.

Note:-

Attribute of a tag defines the features of a given tag in its starting
tag..

2.6.1 Some of the commonly used container tags are defined below:

30




Above tags are explained in the example as shown in fig 2.6.

Fig 2.6
The output will be displayed as shown in fig 2.7

Fig. 2.7

2.7 Attributes:

2.71. Difference between Tag and Attribute:-

Tag

Attribute

/. Tags are those instruction which displys
information on webpage.

An attribute defines a property of
tags

0. Tags may contain attribute

Attribute is a part of opening Tag
of an element.

1. These are of two types:-Empty Tag and
Container Tag

Types of Attribute depend upon
the tag used .ie. each tag has its
own number of attributes.

2. Example-
<Table >
Here table is a tag.

2,&v_k njc8
<Table Border="3" >
a. Here a table is the Tag and
border is its attribute.
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2.8 Body tag with attributes
Body Tag is the main part of the HTML document in which whole information about

the webpage resides. The main attributes of this tag are background, bgcolor and text.

Let us discuss these attributes used in Body Tag.

2.8.1 Background attribute is used to define the background of a webpage. This is
explained with an example in the figure as shown in html code and output in fig
2.8 and 2.9

<BODY BACKGROUND="lampbg.jpg”>

Fig: 2.8 Fig: 2.9
2.8.2 Bgcolor attribute of body tag is used to change the background colour of the
webpage.
eg. <BODY BGCOLOR="GREEN">
EXPLAINED as shown with html code and output in fig 2.10 and 2.11

Fig: 2.10 Fig: 2.11
2.8.3 Difference between BACKGROUND and BGCOLOR:
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2.8.4 Text attribute defines the color of the text and is defined with an example as
shown with html code and output in fig 2.12and 2.13 <BODY BGCOLOR="RED”
TEXT="WHITE">

Fig: 2.12 Fig: 2.13

2.9 Formatting in HTML document
2.9.1 Heading Tags:
The heading tag is used to fix the heading. There are 6 levels of heading . The
levels are numbered as heading 1 to heading 6. All the letters of the heading in
a given level have same font. The font size goes on decreasing as we move from
heading 1 to heading 6. The heading in level 1 is expressed by tags <H1> and
</H1>. Similarly in the heading in level 2 we use the tags <H2> and </H2>.
<H6> is the lowest level. The font size in it is the smallest. Heading tag is used
to define heading in a HTML document.HTML supports Six Heading Levels H1
to H6. Heading tags are container tags.

Example: <H1> Computer Education </H1>

The alignment attribute is used in heading tag. This aligns the text.
ALIGN attributes are of three types viz. LEFT, RIGHT and CENTER.
These are explained with an example as shown with html code and output
in fig 2.13and 2.14with html code and output: -

Fig: 2.14 Fig: 2.15
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2.9.2 FONT: -

Font is pre-defined style and size of the text. FONT is the style and shape of the text
which is used in any document. It allows to format data on a given web page.

Font has four main properties:

1. Style: Font style can be changed in three ways - Bold, Italic and Underline.

a. Font face: Face defines the type face to be used like writing.
2. Font colour: Font colour gives different colours to the text.
3. Fontsize: Font size changes size of text matter.

2.9.2.1. Face defines the type face to be used for the text.eg.

<FONT FACE="ARIAL”>WELCOME TO HTML</FONT>

These are defined with an example as shown with html code and output in fig
2.16 and 2.17

Fig: 2.16 Fig: 2.17

2.9.2.2 COLOR defines the colour of the font to be used. It is defined with an
example as shown with html code and output in fig 2.18and 2.19
<FONT FACE="ARIAL” color="RED”>WELCOME TO HTML</FONT>

Fig: 2.18 Fig: 2.19
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2.9.2.3. SIZE defines the size of the font. It has values from 1 to 7, while 1 is the
smallest and 7 is the largest font size. By default font size is 2. font size 1 means
6 points, 2 means 12 points and so on.
Example of font and its attributes are defined as shown with html code
and output infig2.20and 2.21: -

Fig: 2.20

Fig: 2.21




2.9.3 Paragraph Tag:- It is a container tag which is used in Web page to
make paragraph. Single large documents are not recommended in a
webpage as it is not edited easily. So, it is highly recommended to divide the
text or document in different sections which is possible through paragraph
tag<P> When we use this tag a blank line is inserted before and after the
paragraph automatically by the browser.

Ex. <BODY> Computer is an electronic Machine. It is a data
processing machine. <P> and has memory </P> <BODY>

This is a container tag.

The text will automatically go to the new line after tag <P>

<P ALIGN="RIGHT”>

<P ALIGN="LEFT">

<P ALIGN="JUSTIFY">

<P ALIGN="CENTER”>

EXAMPLE OF <P> TAG.WITH OUTPUT:-
This tag is defined with an example as shown with html code and output
in fig 2.22and 2.23

Fig: 2.22

Fig: 2.23
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2.9.4 Empty TAG
2.9.4.1 BREAKTAG<BR>

The line Break tag is used to start the text from the new line. This tag
does not leave a blank line space as the paragraph tag does. The text jumps
to the new line on using break tag. The tag <BR> is a symbol for line
break.The<br>tag inserts a single line break. The <br>tag is an empty tag
which means that it has no ending tag.This is defined with an example as
shown with html code and output in fig 2.24 and 2.25

Fig: 2.24

Fig: 2.25

2.9.5 Difference between Paragraph Tag and Break Tag.

Paragraph <P> Tag

Break <BR>Tag

<p> tag Tagis a container element which marks a
block of text as a paragraph in a webpage and the
web browser leaves a line between two
paragraphs. This tag has an attribute ALIGN,
which can take three values - left, right and center
.The <p> tag denotes a paragraph and ends witha
</p> and is a container tag.

< BR> tag is an empty element that
is used to break a line and display
the proceeding text from the next
line, without giving any space
between two lines. It has no
attribute. The <BR> is a line break
and is an empty tag.

This tag is used to define paragraphs with in your
text.

This tag is simply aline break. It
just jumps to the next line without
any spacing or formatting options.

Example:- <p>hello world</p>

Example :- Hello<br>world!

2.9.6 HR Tag

The <HR> tag is used to insert horizontal line across the page. Its

attributes are:

e Size : It is used to set the thickness of line.
e Width : It is used to set the length of line.

e Align : It is used to set the alignment of line.
e Color : It is used to set the color of line.

These are explained in Fig 2.26 and 2.27
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Fig: 2.26 Fig: 2.27

2.10 Lists
While accessing some information from the web, user prefers to

read only the required information from the website. So, lists play an
important role in defining important information in the form of few lines.
For example. As the user wants to differentiate between two distinct
objects, then it will be better to represent it in the form of lists. In HTML
there are three types of lists available.

These are as follow:-

1. Numbered Lists (Ordered List)

2. Bulleted Lists (Unordered List)

3. Definition Lists

2.10.1 ORDERED LIST :-

Also known as numbered list ,it is used to define a list in a specific
or sequential order in which numbers are used. The basic tag used for
Ordered list is <OL> tag at the starting and</OL> at the end of the list.
Each item is marked with an<LI> (List Item)tag. By default the list is
started with 1. But user can change the starting number.

ATTRIBUTES USED:- In an Ordered List the attributes used are “TYPE®
which have values as 1(Arabic),A(upper case letter),a(Lower case
letters),I(Upper case Romans),i (Lower case Romans).

Eg.<OL type="I">

Second attribute used is START in which user can define his own

starting value in the list.
Eg.<OL Start="5" Type="i" >
Ordered List example is shown as follows inexample as shown with
html code and outputin fig 2.28and 2.29
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Fig: 2.28 Fig: 2.29

2.10.2 Unordered List (Bulleted List) :-

The lists which have information related to each other but their
sequence is not important are called Bulleted Lists. It has a starting tag as
<UL> and ending tag as </UL>tag. Each item is marked with <LI>tag which
stands for List Iltem. Any number of elements can be added in it. This
is defined with an example as shown with html code and output in fig 2.30
and 2.31

Fig: 2.30 Fig: 2.31
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By default attribute used for bullet list are used as disc. But these
bulletscan be changed by using an attribute as TYPE .It can be used in
<UL> as well as in <LI> tag as per the requirement. the values support by
this attribute is defined as

Disc (@)

CIRCLE(©©O)

SQUARE(m)

These are explained and defined with an example as shown with html

code and outputin fig 2.32 and 2.33

Fig: 2.32 Fig: 2.33
2.10.3 Difference between Ordered List and Unordered List
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2.10.4 Definition List:-
Definition list generally contains the definitions of different terms and

their meaning. It starts with <DL> tag and ends with</DL>tag. It has two
main tags definition Term <DT> and Definition Description <DD> tags.
These are explained in the following example as shown in figure 2.34 and

2.35 with html code and output.

Fig: 2.34

Fig: 2.35
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2.10.5 Nested Lists:-

When a List is inserted in other list it is known as Nested List. We
can explain the nested list with the following example as shown with html
code and output in fig 2.36 and 2.37

Fig: 2.36 Fig: 2.37
2.11 IMAGES:-

By now you know enough to write a very nice, text-based home page
in HTML, but it is the ability of the Web to provide pictures, technically
called images, graphics, or sometimes icons, that has made it so popular.
In this following section we 'll learn how to place an image in our web page
and attributes related to it. Various graphics formats used are
jpeg,.jpg..gif, png etc.

To add an image to a webpage, the tag used is <img
SRC=""FILENAME”>.Here SRC defines the source of the image and file

name defines the filename with extension of the image chosen.
NOTE:-The location of the image file must be defined properly. i.e.

either the file is in the same folder in which web page is stored or User has

to define the complete path of the file.
Eg If file is in the same folder then it can be defined as
<Img SRC="green.jpeg">
OR
<img SRC="C:\html\10class\green.jpeg”>
The attributes of image tag are defined below:-
1. ALT stands for "alternate text". This tells the browser that if it

can't find the image, then just display this text. For example a disabled
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user using a screen reader,visit the webpage, When the mouse over the image,

the alternate text pops up.
Example for this is as follows:
<Img SRC="green.jpeg” Alt="green color image is shown”> and are

explained with an example as shown with html code and output in fig 2.38
and 2.39:-

Fig: 2.38 Fig: 2.39
2. WIDTH stands for the image in pixels as well as percentage of the

web browser window. It can range from 1 pixel to any number, but
generally will be less than the width of the web browser.

3. HEIGHT stands for the height of the image in pixels or percentage
of the web browser windows. Again, the height can be just about
anything, but generally will be less than the height of the web
browser.

Example<img src="images2.jpeg” height=50% width=30%>
These are explained with an example as shown with html code and output
infig2.40and 2.41:-

Fig: 2.40 Fig: 2.41
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4.  Align defines the alignment of the attached image in contrast to the
other contents of the webpage. It has different values left, right, top

and bottom.
Example for this is as follows
<img src="images2.jpeg” align="Right” >

Note:

To increase the space at the top and bottom of an image, use VSPACE
and HSPACE.

These are explained with an example as shown with html code and
output in fig 2.42 and 2.43:-

Fig: 2.42 Fig: 2.43

Similarly other alignments can be performed by changing align attribute
values.

2.12 Tables:

2.12.1 Creating Tables in HTML: -

In previous topics we have explained the various aspects in which
information is defined in the form of sentences and paragraphs. However, the
information can be defined in the form of columns and rows or tabular form. It
allows tomanage the information in to multiple rows and columns. The HTML
tables allow web authors to arrange data like text, images, links, other tables,
etc. into rows and columns of cells. It makes the webpage attractive. Table
begins with <Table> tag and ends with</Table>. Table has various attributes
which will be discussed later. Table tag has various other tags which are
explained below ;-

1. Table Heading<TH>.It defines the table headings of a given table. It
starts with <TH> tag and ends with</TH>tags. It should be defined with
in the Table Row<TR>.

2. Table Row<TR>.It defines the row in a table. Table heading and table
data are defined with in the row which starts with <TR> Tag and ends
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with </TR>
3. Table Data <TD>It defines the data of the table. Table data defines the

information stored in the table. It starts with<TD> data and ends
with</TD>.

Let us explain all these tags as shown with html code and output in fig
2.43and 2.44.

Fig: 2.44 Fig: 2.45

2.12.2 Attributes of Table Tag:-

Border:- The border attribute defines the width of the table border. It has
0 value for no border and by default value is 1.
Example for this is as follows.
<Table Border="1">
ALIGN:-  Align attribute defines the alignment of the table in the browser
window. It has left, right and center values.
Example for this is as follows.
<Table align="Right" Border="1">
BORDERCOLOR: - It defines the color of the border.
Example for this is as follows.
<Table BORDER=2 BORDERCOLOR="RED">
WIDTH:-Width defines the width of the table. It can be defined in pixel or as
a percentage of the web browser window.
Example for this is as follows.
<Table WIDTH="35 %">
It defines the 35% space of the browser.
<Table WIDTH=500>

It defines the 500 pixels space of the browser. All the above tags
are explained with an example shown in fig 2.46 and 2.47
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Fig: 2.46

Fig: 2.47

2.12.3 CELLSPACING is the pixel width between the individual data cells in
the TABLE. (The thickness of the lines making the TABLE grid). The default
value is zero. If the BORDER is set at O, the CELLSPACING lines will be
invisible.

Example for this is as follows.
<Table Border="2" cellspacing=12> and is explained with an example as shown
with html code and output in fig 2.48and 2.49
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Fig: 2.48 Fig: 2.49
2.12.4 CELLPADDING is the pixel space between the cell contents and the
cell border. The default for this property is also zero. This feature is not used
often, but sometimes comes in handy when you have your borders turned on
and you want the contents to be "away" from the border a bit for easy viewing.
CELLPADDING is invisible, even with the BORDER property turned on.

Example for this is as follows.
<Table Border="3" cellpadding=10>These are explained below with html

code and its output as shown in fig 2.50 & 2.50

Fig: 2.50 Fig: 2.51

2.12.5 COLSPAN and ROWSPAN. Table cells can span across more than
one column or row. The attributes COLSPAN ("how many across'")defines the
combination of one or more columns together while ROWSPAN ("how many
down") indicates how many rows to be combined together.

Syntax for this is as follows.

<Table Border="1" colspan=2>

<Table Border="1" rowspan=2>

These are explained with an example as shown with html code and
outputinfig 2.51 and 2.52:-

47




Fig: 2.52 Fig: 2.53
2.12.6 Difference between Colspan and Rowspan

2.12 Table Background:-
BACKGROUND attribute is used to set the background image in the
given table.
The example for this is as follows:-
<table background="up.jpeg” border=2> This is explained below
with an example.
These are explained with an example as shown with html code and
output in fig 2.54 and 2.55:-
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BGCOLOR:-BGCOLOR is used to set background colour of the table. The
example used for this attribute is as follows:-

<table bgcolor="yellow” border=2>This is explained below with an
example.(Fig. 2.56 and 2.57)

Fig: 2.56 Fig: 2.57




goints to Remember

1. HTML is a Hypertext markup Language which is used to design
webpage.
2. HTML codes are defined in Tags.
3. There are two types of element tags: Container and empty tags.
4. Container has both opening and closing tags while empty tags have
single tag.
S Web browser is used to see the output of html Program example Google
chrome, Internet explorer, Firefox, Opera etc..
6. Heading tags can be defined between <H1> to<H6> Tags.
7. User can format his/her text using various tags example. <B>, <U>, <I>
etc.
8. .html or .htm is the extension of HTML program.
O Each tag has some attributes which are used to define the properties of
that tag.
10. There are three types of lists these are ordered, unordered and
definition lists.
11. Nested Lists are used to represent list with in list.
12.  User can connect multiple webpages together with linking.
13. Linking of pages can be done using Anchor<A> tag.
14. Information can be defined in the tabular form, the tag used for this is
<table>.
15. <IMG> Tagis used to define images in a web page.
3. A webpage displays a picture.
What tag was used to display that
1 picture?
ExerCISe a. picture b.mage
c.img d. src
1. Multiple Choice Questions: 4. Page designed in HTML is called a
1. What should be the first tag in a. Yellow Page b. Web Page
any HTML document? c. Server Page d. Front Page
a. <head> b. <title> 5. HTML document is saved using
c. <html> d. <document> ____extension.
2. What is the correct HTML tag a. .htl b. .html
for inserting a line break? c. .hml d. .htnl
a. <br> b. <lb> 6. Table tag has various other tags,
c. <break> d. <newline> these are

a. <TR>. b. <TD>.
c. <TH> d. All of the above.
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2 Fills in the Blanks: -

1. HTML stands for

2. list to represent an
unorganized list.

3. Tag is used to define

. Name a tag which

in which whole information about the
webpage resides.

is an empty
element that is used to break a line

and display the proceeding text from

the elements of a list.

4. ALT stands for

the next line, without giving any

space between two lines.
5. is the main part of 4
the HTML document in which

. Name the list which have

information related to each other

whole information about the

webpage resides. but their sequence is not important
6. The contains title that 6 Short questions:-

identifies the heading of the html 1. What is HTML?

document. 2. What is a Tag?
D Ralse:s 3. What is <Img> tag. Explain.
1. HTML is a structured Language. 4. Name different tags used to create

2. Table heading starts with <TH> tag
and ends with</TH>tags 5

a table.

. Explain Font tag with its

3. Align does not defines the alignment attributes.

of the attached image in contrast to 2 pifferentiate Between:-
the other contents of the webpage

1. Ordered and Unordered List.
4. CELLPADDING is the pixel space
between the cell contents and the 2. Background and BGCOLOR.

cell border. 3. Colspan and Rowspan.

5. Definition list generally contains the 4.
definitons of different terms and
their meaning.

4 FULL FORMS:-

1.HTML 2. <B> 3.<I> 4.<U>
5<0OL> 6.<UL> 7.<P> 8.<BR>

9. SRC 10.<IMG> 11. <TR>
12.<TH> 13<TD> 14. LI

15. URL.
5 Very Short Questions
1. Name the tag which is by the
beginning and ending tags.
2. Name the tag ofthe HTML document

Tag and attribute.
8. Long questions:-

1. Describe the basic structure of HTML
in Details.

2. What are the various tags used in
table?Explain with an example.

3. Explain ordered list with an example.

4. Explain Nesting List with an example.
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HTML
'y HTML- I </>

Objectives of this chapter:

Introduction
3.1 Hyperlink.

3.2 Forms.
3.3 Buttons.

3.4 Multimedia in HTML.

Introduction:

In the last chapter we have already discussed the different aspects of
HTML which includes how to create a simple webpage, lists, tables etc. Now in
this chapter Marquee ,Hyperlink,adding external audio and video to a web
page in HTML will be discussed.

1.1 Hyperlink:

Link is an important property of HTML. With the help of hyperlink, any
text or image available in Web page can be link to any other document. Link is
also named as Hypertextlink or Hyperlink. Browser shows the Hyperlink in
blue colour and also underlines it. LINKING means connecting multiple
webpages with each other.Each website has multiple webpages related to its
different information stored.In HTML linking is defined with HYPERLINK .It
provides links between different webpages of the website .Usually links are
defined into two types internal links (which are defined with in the same
website) and External Links(which are defined to the links defined outside the
website). Hyperlinks can be defined on text or images on the given webpage.
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Fig: 3.1 Fig: 3.2

3.1.2 LINKING IMAGE AS A HYPERLINK

As we have defined earlier the hyperlink can be defined on text as well as
other elements of a webpage. We can define hyperlink on an image also.
Eg.<A HREF=“bodybackground.html”><image src=“lampbg.jpeg”
HEIGHT=70% WIDTH=60%" >

Here in the above example a hyperlink is created on the image
“lampbg.jpeg”.In this user has to define anchor tag and img src tag to create a
link on the given image.

Create html program “Link.html” with an image, then create another

program with hyperlinking.html as shown in the in Fig 3.3 (a) & Fig. 3.3 (b) and
outputin Fig. 3.4 (a) & Fig 3.4 (b) And see the results

Fig: 3.3 (a) Fig: 3.3 (b)
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Fig: 3.4 (a) Fig: 3.4 (b)

3.1.3 Linking to email address
We can link an e-mail address by using an Anchor Tag. With this a user

can send e-mail by clicking on the link.
The code used for linking to an e-mail address is as follows:
<A HREF = mail to: abc@rediffmail.com> mailme </A>.
Here abc@rediffmail.com is e-mail address and mailme is the

hyperlink.
3.2 Forms
An html form is part of a web page that includes areas where readers can

enter information to be sent back to WEBSITE or the publishers of the web
page It is a container that consists of other form elements such as text box,

radio buttons,list box etc.
Every form include the action and method attributes to complete the

purpose of entering information in a form. These are explained below:-
Action:

The action attribute specifies where to send the form-data when a form is
submitted. FORM is useless unless some kind of processing takes place after
the form is submitted. The action attribute is used to inform the browser what
page (or script) has to be called, once the SUBMIT button is pressed. It
Specifies a URL to which the form's data is sent when submitted.
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Exp. <FORM ACTION="welcome.php">
Method:

The method attribute defines the way through which user's
information, which is entered in the form, can be sent and stored to the
website server. There are basically two methods through which information
can be sent.

Get Method:

This method is used to send the entered data by the user by using URL
path and is sent to the server. Limited data can be sent to the server. Its
parameters remain in the browser history.
<FORM method= "get" action="welcome.php">
Post Method:

This method is used to store the data to the server without interfering
URL and is more secure to send information than GET method There is no
restriction on sending data. Its parameters don't remain in the browser
history.

<FORM method="post" action="welcome.php">
3.2.1 CREATING A FORM:

Every form must begin with a <form>tag, which can be located
anywhere in the body of the html document and ends with </form>.Different
controls are available which can be used in a form. These are explained
below:-

3.2.2 Text Box: <Input>tag

This is a simple type of form control available and is used to ask the
user to enter specific piece of information within a form, It uses the <input >
element.Type is the attribute which can be used in the input element to
determine the type of control which user wants to use with in the form. This
tag must fall between the <form> and </form> tags, but it can be anywhere
on the page in relation to text, images, and other html tags. For example, If
user asks for someone's name you could type the following :

What's your first name ?<input type="text" name="fullname" size="20" >
Here type defines the type of input needed, name defines the name of the field
, that is used to retrieve the information from the form, size defines the size of
the text. If web designer wants the user to enter text without it being
displayed on the screen, he can use <input type="password" > instead of
<input type="text">. Asterisks (***) are then displayed in place of the text.

56




Below html program shows the text input and its related output

Fig: . 3.5 Fig: . 3.6
3.2.3 TEX AREAS:-

This is a container tag and is used to allow multiple lines of text in a
single input item. It has two attributes these are ROWS and COLS .Row defines
the number of rows defined in the text area and cols defines the number of
columns used in the text area. If user wants to define some default text then he
can define in-between the opening closing tags of text area element. All this is

explained in the given example.
<textarea name="comments" rows="4" cols="20">
Please send more information.
</textarea>
The rows and cols attributes control the number of rows and columns of text

that fit in the input box. Textarea boxes do have a scrollbar, so that user can
enter more text than fits in the display area.
3.2.4 CHECK BOXES:

The simplest input type is a checkbox, which appears as a small square
the user can select or deselect by clicking on it. It is generally used where a
group is used for sharing a common name from where information can be
selected. It is used in <input> html element. We must give each checkbox a
name attribute the value defined in the type attribute is checkbox. These are

explained below with an example.
<input type="checkbox" name="baby" value="baby" >baby grand piano
<input type="checkbox" name="mini" value="my mini"> mini piano stool
You can check any option or both by clicking on it. It also supports some
additional attributes
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3.2.5 RADIO BUTTONS:

Radio buttons, are those buttons where only one option can be selected
at a time and are almost as simple to implement as check boxes. It is used in
<input> html element. User must give each radio button a name attribute
and the value defined in the type attribute is radio. Just use type="radio" and
give each of the options its own input tag, but use the same name for all of the
radio buttons in a group These are explained below with an example.

Ex. <input type="radio" name="card" value ="visacard'"> visa

<input type="radio" name="card" value="mastercard"> master card

Below in Figure 3.7 and 3.8 html program shows the text input and its

related output.

Fig 3.7 Fig. 3.8

3.2.6 SELECTION LISTS:

In this option user can select single or multiple options from a range of
options. In this option multiple inputs are available but some options can be
displayed at a time. Scrolling Lists and Pull-Down pick lists are created with the
<select>tag. You can use this tag together with the <option>tag :

Exp. <select>

<option value ="ewin"> electric windows</option>

<option value ='amfm"> am/fm radio</option>

<option value ="tocharges">turbocharger</option>

</select>

No html tags other than <option> and </option> should appear between
the <select> and </select> tags.
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Attribute of select tag:-
Size: Size attribute here it determines how many items are to be shown at once
on the selection list. If size="2" were used in the preceding code, only the first
two options would be visible, and a scrollbar would appear next to the list so
the user could scroll down to see the third option.
Ex.: <Selectname ="Month” size="3">
name:-It is used to define name to the drop down menu.
<Select name ="Month” size="3" multiple>
Multiple:-This is used to select multiple options from the given option.
Value:-This is the value which has to be given back to the website and defined
in the option tag.
Ex.: <option Value="jan”>January
Selected:-When this option is used one option will be preselected.
Let us discuss an example related to this topic as shown in figure 3.10 and 3.14

Fig. 3.9 Fig. 3.10

3.3 BUTTONS

Buttons are used to perform some action on the given webpage.Some
important buttons are discussed below.
3.3.1 SUBMIT:-

Every form must include a button that submits the form data to the
server. You can put any label you like on this button. It has two attributes these
are type, which has submit value and value attribute defines the name of the
submit button which can be displayed on the button. These are explained
below with an example

Ex: <input type="submit" value="OK" or

<button type="submit'value ="sumbit'">
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A button will appear on screen. When the user clicks it, all data items on the
form are submitted
3.3.2 RESET Button:

you can also include a button that clears all entries on the form so
users can start over if they change their minds or make mistakes. It has two
attributes these are “type”, which has reset value and value attribute defines
the name of the reset button which can be displayed on the button. These
are explained below with an example

Ex. : <input type="reset"value="CLEAR ALL"”>

or <button type='rest" value ="reset">
All parts of a form must fall between the <form> and </form> tags Button
are explained with an example as shown in figure 3.11 and 3.12

Fig. 3.11 Fig. 3.12

3.4 Multimedia in html:-

3.4.1<MARQUEE> :-This tag is used to move the text in the webpage. This
is a container tag. This tag has some attributes which are generally used.
These are defined in the following table
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Attribute Purpose Syntax Example

name

BGCOLOR This attribute defines the | <Marquee <Marquee = BGCOLOR
background color of the text. | BGCOLOR=“COLOR =“GREEN">

NAMEGREEN">

DIRECTION This attribute defines the | <Marquee <Marquee
direction of the text ie. | direction="side”> direction="Left”>
right,left,up,down.

HEIGHT Defines the height of the text | <Marquee height="pix>> | <Marquee height="50">
in pixel.

WIDTH Defines the WIDTH of the | <Marquee <Marquee Width="20">
text in pixel. WIDTH=“pix>>

BEHVIOUR It defines the scrolling if the | <Marquee <Marquee

Text with three values

1. Scroll : infinitely scrolls
the text

2. alternate: moves text left
then right.

3. slide: brings the text from
left or right of the webpage.

behavior="value”>

behavior="scroll”’>

<Marquee
behavior="alternate’”>

<Marquee
behavior="slide”>

Marquee tag is explained with code and output as shown in Fig. 3.13 and Fig
3.14 Following example all the above attributes:-

Fig. 3.13

Fig. 3.14
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3.4.2 Adding audio/video files to HTML programs

User can link audio/video file to html program by using Anchor tag .As
we have used this tag to link files with html webpage. We have to define the
path of the audio/video file in HREF attribute. Whenever user clicks on the
given link the file will be downloaded on the user's system and can be played
with supported software.
This is explained with an example in fig. 3.15and 3.16

Files

Fig. 3.16

7

...... </A>anchor tag is used to define hyperlink.
Form is a part of a webpage that includes areas where readers
feed information which can be forwarded to the webserver.

3. Text input and textarea tag is used to define text format in the
webpage.

4. Checkbox is a small square that user can select from given
options.

5. Radio Buttons can be used to select single option from the given

set of options.

Buttons are used to perform a specific job or task.

Marquee Tag is used to move the text in the webpage.

8. Anchor Tag can used to link audio or video files to the webpage.

Rl
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" 4.

Exercise
1. Multiple Choice Questions: 5
1. What is the use of Forms in HTML? 3
a. to display contents of email. *
b. to display animation effect. 1.

c. to collect user's input.
d. None of the Above. 2.

2. Which of the following is most
commonly used HTTP methods? 3.
a. PRE and POST.
b. GET and SET.
c. ASK and REPLY.
d. GET and POST.

3. Is it possible to link within the
current page ? 5.

a. Yes. 1.

2.
b.No.
c. Only In frames
d. Null. S

4. An html form is part of a web
page that includes areas where 4
a. Information is feeded by the :
user.

b. And sent to the website server. 6.
c. Both a and b. 1.

d. None of the above. 9

5. A container tag is used to allow
multiple lines of text in a single
input item is known as

To select multiple options in a form
we can use .(Checkbox)

To clear all options from a form we can
use button.(reset)

True or False:

An unvisited Link is underlined and
blue.

<input type="password”> will show
asterisks in the text box.

Selection lists are used to define the
dropdown lists.

Full forms:-
1. <A> 2. HREF 3. URL
4. BGCOLOR 5. SRC

Short Answer type Questions:

Which tag is used to link a webpage.
Which attribute is defined to specify
where to send the form-data when a
form is submitted.

This method is used to encode the
feeded data by the user by using URL
path and is sent to the server.

What are used to perform some
action on the given webpage.

Long Answer type Questions:

Whatis hyperlink?

What is Anchor tag? Explain with
example.

Whatis a form?

a. Textarea. 4. Name different types of buttons used in
b. Checkbox. html form.

c. Radio Button. 5. Whatis checkbox?

d. None of the above. Long Questions:

2. Fill in the Blanks:

1.
1. tag is used to create a link on
awebpage.
2. is used to send information 2-
into the webserver.

3. If you want to allow multiple lines of
text is used in the
form(Textarea)

Discuss different types of buttons
with example.

What is selection list in form?

Explain TextArea with an
example.

What is the purpose of action and
method in forms?
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Multiple Fill in the True or
ti Full F Sh tA
Questions Choice Blanks False ull Form ry ort Answer
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Chapter
4 WEB DEVELOPMENT

Objectives of this chapter:

4.1 Planning for website.

4.2 Web Implementation Guidelines

4.3 Aspects related to publishing a website
4.4 Important guidelines or checklist.

4.5 Project: School Website

Introduction

We will learn to make small projects and we will also know that how a
website is planned and launched on internet. There are four stages of planning
a website viz: goal of site, designing for viewers, work strategy, development of
subject matter. Similarly there are many stages to put website in use for,
example, selection of name of Domain, Registration of Domain Name, selection
of Server, testing the website off-line as well as on-line etc.

4.1 Planning for website.
The website developed by proper planning is always effective. To build a
website we should first make its planning. If done with proper planning, the
objective of site would be fulfilled. We communicate through websites. Hence
we have to decide while planning that what we wish to communicate and by
which technique. First & foremost purpose of designing a website is to keep in
mind the goal and target of website. The website should always be built to
achieve its goal.
4.1.1 The goal of the Site

Every site has some specific purpose. This purpose guides us what to
include in the site. User can prepare a detailed and decorative site. But the
condition is that it must support the purpose of the site. The following facts are
to be kept in mind while building a site:

[ Purpose of organization.
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important purposes of your site.
Method to develop the site
Fulfilling these requirements.
Working strategy of site to achieve the goal.
Time of developing the site.
e Time of updating the site.
4.1.2 Designing for the Audience

After fixing the aim of website, we have to know about nature of viewers of
the site, which type of people will be hitting it: children, students, advocates,
doctors or housewives. We have to keep in mind about their expectation from
your site.

For example if the designer is building the site for a publisher then the
viewer's certainly would be students, children, teachers, professors and other
intellectuals. In such a case the site will be designed according to their interest
and expectations.

4.1.3 Strategy

When the designer has decided to build a particular site, we will have
to think about its work-strategy. The mode of works to carry out for
achieving the goal is called work-strategy. Many kinds of information can
be included in the website.

e Text information

e Audio or Voice information

e Video information

A simple website is good and impressive. In other words it should not be
complicated.
4.1.4 Contents

After finalizing above jobs we now need the contents of site to enter. The
contents of the site supplies all the important information to the viewer, hence
the contents should be at proper place and arranged systematically. If there
are links in a sequence, then it is easier to search the required information.

4.2 Web Implementation Guidelines

After making complete and proper planning and deciding about
information (contents) and links we have to work for its implementation part.
We probably know that the content of the website is its most important aspect,
but it's also very important that its intended audience are able to find it, and
that visitors to our site can quickly locate the information they are seeking. It's
also a good idea to check that it's thoroughly optimized to attract new visitors
and track their activities.

Selection of Domain Name, Registration of Domain, Selection of server
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and managing the site etc. are under the Web Implementation Plan.

4.2.1 Choosing Domain Name

Domain name is the address of your site .Choose a domain name that
is brief, easy to remember, and suited to the content of your website. Some
common top-level domains include .com, .edu, .org, and .net, which stand
for commercial, education, organization, and network respectively. It should
not include hyphens. Maximum numbers of letters included in it can be 63.
4.2.2 Registering Domain Name

After deciding about the Domain Name, we have to register it. Designer
can register the site through the service provider. Service provider asks to fill a
form and also charges fee for its registration. After filling the form it is verified
whether the Domain name provided by the designer is free and is not already
registered by anyone else. If the name is available then designer gets the
confirmation message about registration through email.
4.2.3 Choosing a Server

To put the site in practice we have to choose the server or host. It is very
important task Designer can buy or hire the server where the site is to remain
permanent. In the web world the role of server is very important. Such a
specific server is named Web server. Whenever designer opens any site on the
browser, it connects to the concerned server. Securing the bandwidth
necessary to keep the website running smoothly. Bandwidth is the amount of
data transferred within a given time period.
Designer may need to buy more bandwidth as the website grows or else the
visitors may experience lag, which could drive them away from the website.
Many hosts also provide software aid in building the website.
4.2.4 Organizing Web page

If a person cannot find what they are looking for on the website within 30
seconds, there is a good chance they will leave and never return. Organizing
the website into specific sections and then providing links to those sections at
the top of each page is an effective and simple way to make the website easy to
navigate. The Webpage should be beautifully organized. So that it gives a
balanced look. The size of the page is an important point in organizing
webpage. The following points must be kept in mind while designing a
webpage.

1. Size of a web page should not be more than two screens. If we have to

use a longer page, the establish internet link through bookmark.
2. Ifthe document is longer than one screen then show only a part of it to
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the viewers and remaining part maybe shown only on their demand/

requirement.
4.2.5 Look

Webpage should have a fine look so that one is attracted to read it. In a

webpage with a good look designer should insert links graphics, animation,
sound and video clips. The various contents in the webpage should give an
impression of diversity and a beautiful view. Usage of proper font size/colour,
background colour, table, graph etc. gives a good look to the site.
4.2.6 Validate the code.

Validate the HTML, CSS, XHTML, JavaScript, and XML codes to ensure
that the website has clean code and function as intended for visitors. There are
several programs available online that validate each type of code.

4.2.7 Offline Testing

After designing all the webpages it is tested on the browser. No internet
connection is required for this test that is why it is named as offline test. In
offline test first of all home page is opened in different browser. Then we check
all the linked pages one by one. Designer should ascertain it here that all pages
have a good appearance. The website should be thoroughly tested to confirm
that the design and page structure are displayed as intended. Specifically,
view the website with the most popular browsers, including Chrome, Firefox,
Internet Explorer, Opera, and Safari, as those browsers are used by the
majority of people who are browsing the Internet.

4.2.8 Uploading the Site
To make the site available to all the viewers on the internet is called Upload.

To transfer the webpages to the "Host" we need File Transfer Protocol (FTP) client.
For this purpose first of all we set FTP programmer as Cute FTP. Then upload
the file after coming online. The copy of the website on computer is called the
localversion, and the copy on the web host is called the production version.

4.2.9 Online Testing

When the site is uploaded online, next step is to test it online. Make the
internet connection, open the browser, and type URL of the site. Check that all
the links of the site are working property.

4.2.10 Using SEO-friendly code.

Utilize both Meta and ALT tags to ensure that the website not only
appears in user searches but that pertinent keywords from the content of the
website are displayed. Doing so will more likely attract searchers' interests and
will facilitate more visits to the website. ALT tags are merely a written
description to go along with the pictures on the website, and so they are
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necessary to tell search engines and searchers what kind of pictures are there
on the website.
4.2.11 Installing website analytics

The statistics will enable to monitor the number of visits website
receives, the amount of time visitors stay, the average number of page views
for each visitor, and many other useful statistics. Making use of such
software will enable to make adjustments to the website to increase its
effectiveness.

4.3 Some important aspects related in publishing website
4.3.1 SEO

SEO means search engine optimization. Search engine optimization is a
methodology of strategies, techniques and tactics used to increase the amount
of visitors to a website by obtaining a high-ranking placement in the search
results page of a search engine including Google, Bing, Yahoo and other search
engines.

SEO helps to ensure that a site is accessible to a search engine and
improves the chances that the site will be found by the search engine. SEO is
typically a set of practices that webmasters and Web content producers follow
to help them achieve a better ranking in search engine results.

4.3.2 Social media marketing (SMM)

SMM is a form of Internet marketing that utilizes social networking
websites as a marketing tool. The goal of SMM is to produce content that users
will share with their social network to help a company increase brand exposure
and broaden customer reach.

One of the key components of SMM is social media optimization (SMO).
Like search engine optimization (SEO), SMO is a strategy for drawing new and
unique visitors to a website. SMO can be done in two ways: adding social media
links to content, sharing buttons or promoting activity through social media by
updating statuses or tweets, or blog posts.

SMM helps a company get direct feedback from customers (and potential
customers) while making the company seem more personable. SMM became
more common with the increased popularity of websites such as
Twitter,Facebook, Myspace, LinkedIn, and YouTube.

4.4 Some important guidelines or checklist which must be noted while
publishing website.
4.4.1 Page Content

1. Spelling and grammar, paragraphs, headers, lists, and other formatting
should be correct.
2. Company contact details are accurate throughout the website.
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3. Images and audio and videos are in the correct places, formatted and
working on all devices.
4.4.2Design
Take the necessary steps to ensure that the site design is pixel perfect. If
designer has a responsive website. It needs to check the design across all
devices. The site should be looking good not just on an office desktop, but also
on laptops, tablets, and mobile phones.
4.4.3 Functionality
Take some time to test and validate all of the different features on the
website. Lead generation forms, social sharing, should work flawlessly across
the website such as:-

1. Thank-you message or page displays after form is submitted.
2. Company logo is linked to the homepage.
3. Load time for site pages is optimized.

4.4.4 SEO

Take some time to ensure that the website has been given a solid
foundation for SEO success. From site architecture and content to metadata
sitemaps, do not leave any stone unturned such as:

1. Pages have unique page titles (fewer than 70 characters,

includes keywords).

2. Pages have keywords (fewer than 10, all words appear in page

copy).

3. Spelling and grammar are correct in all information.

4. Alt tags have been added to every image.

4.4.5 Security & Backups

Designer can prevent loss of data and protect against malware and other

damages by properly setting up site security and regular backups.

1. 24 x 7 monitoring scripts are installed.

2. A copy of the final website has been made for backup purposes.

3. Ongoing copies of the website are being created and stored on a
regular basis.

4. Passwords and other website credentials are stored in a secure
database.

4.4.6 Compliance

Finally, make sure the website complies with any applicable laws and
regulations. Internet law can be hard, and each industry has its own set of
rules to follow. Following are a few rules one needs to know about:
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1. Web pages offer accessibility for users with disabilities.
2. Terms and privacy policies are visible to website visitors.
4.3 Project

Project: School Website

We have learnt in details, about planning uploading and online testing
etc of a website. Let us now build a project on the subject of "School
Website'".

For building a project first of all a source file is created in notepad. It is
saved as: with ..html extension. Finally it is run on internet explorer.

There are common tags used in building this project, which we have
studied in previous chapters. This project contains one homepage and eight
web pages. All the eight webpages are linked to home page.

Home page is always the first page of the website. This page contains
all the information available on the site.

Now we are able to make a project in html related to a school ,So that we
can able to implement all the concepts which we have discussed in this and
previous chapters. Let us make a website of a school.

This is the home page of our website. As shown in fig.4.1

Fig 4.1
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Code for this page is as follows in fig 4.2

Fig 4.2
The first Link available in the website is facilities available and the code
and output for this is shown in fig 4.3 and 4.4

Fig. 4.3




Fig 4.4
The second link is admission form which has following output and code as
shown in Fig. 4.5and 4.6(a) and 4.6 (b)

Fig. 4.5
And the code for this form is as follows. Fig 4.6
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Fig 4.6 (a)

Fig 4.6(b)




The next link is for faculty details the output and its code is defined below in
fig4.7and 4.8:-

Fig 4.7
The code for this is as follows

Fig 4.8




The next link is for house details the output in figure 4.9 and its code is
defined below inn fig. 4.10 (a), 4.10 (b) and 4.11, 4,12.

Fig 4.9

Fig 4.10(a) Fig 4.10(b)




Fig 4.11 Fig. 4.12

The next available link is photo gallery as shown in figure 4.13 and the
output and code for this webpage as shown in fig 4.14.

Fig 4.13 Fig 4.14
The next available link is Other helpful websites the output as shown in figure
4.15 and code for this webpage is as shown in fig.4.16
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Fig 4.15 Fig 4.16
The next available link is query/suggestion form the output and code for
this webpage is as shown in fig. 4.17, 4.18.

Fig.4.17




Fig 4.18
The next and last available link is locate us the output as shown in figure
4.19 and code for this webpage is as fig. 4.20:-

Fig. 4.19




Fig 4.20

oints emember

1. Before deciding about the server we should register the domain
name.

28 The needs of viewers should be kept in mind while designing a
website.

3. You can establish your own server or can hire a space for it from

any company or organization.

After designing all pages they are tested off line.

Site is uploaded with the help of FTP (File Transfer Protocol).

After successful uploading, site in tested online.

First page of a site is the home page, all other pages of site are

linked with home

Bandwidth is the amount of data transfer you are allowed

within a given time period.

Test your website in a variety of web browsers.

0. Search engine optimization is a methodology of strategies,
techniques and tactics used to increase the amount of visitors
to a website

SO © NooOok
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Exercise

. Multiple Choice Questions:

There are four stages of planning a
website.
a. Goal of a site.
b. Designing for viewers.
c. Work strategy. And
development of subject matter.
d. All of the above.
A good look of a webpage depends
upon
a. Font size/colour.
b. background colour
c. Table and graphics.
d. All of the above.
No internet connection is needed in
a. Offline testing.
b. Online testing.
c. Both of the above.
d. None of these.
SEO means
a. Search engine optimization.
b. System engine optimization.
c. Syncronized engine
optimization.
d. None of the above.
SMM Stands for
a. Social media marketing.
b. Science media marketing.
c. System macro media.
d. None of the above.

Fill in the Blanks:

While planning to build a site, decision
about....... site is taken at the end.

.............. is the address of your site.

After deciding about domain name next
stepis....ccoeunnen the domain name.

............... test can be done without the
internet.

The very first page of any website is
calledas...................

True or False:

. There is no link of other pages with the

home page

Address of site ends with .com, .org, .net
etc.

Off line testing of a site should be done
on a single browser only.

To send the webpages to host, we need
FTP client.

During online testing of a site your
computer should be connected to the
internet.

Give the full names of

—

w

1.1P 2. FTP 3. URL
Very Short Answer type Questions:
Which is the address of your site .

The copy of the website on computer is

called the version, and the copy

on the web host is called the
version.

What helps a company get direct
feedback from customers.

What is necessary to check all of the
different features on the website.

How can Designer prevent loss of data
and protect against malware and other
damages.

Short Answer type Questions:

Describe the important points to fix
the purpose of a site.

What do you mean by Domain Name?

What is role of server in world of
internet?

What points are to be taken care of
while designing a webpage?

What do you mean by offline testing?
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Long Answer type Questions: 3. What is difference between Ofﬂil’le

. . . and online testing,.
Write the different steps for planning a )
Describe the necessary direction for 5. Whatis SMM?

implementing a website.

Answers Key

m Multiple Choice Fill inthe Blanks Very Short Answer

1. Publishing. FALSE. Domain Name.

d 2. Domain Name. TRUE. Local

,productionExternal Link.

a 3. Registration FALSE. SMM.

a 4. Offline. TRUE. Test and Validate.

a 5. Homepage. TRUE. By taking regular backup
and preventive security
measures.
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Chapter
5 Desktop Publishing

Objectives of this chapter:

5.1 Desktop Publishing

5.2 Desktop —publishing software

5.3 Word Processing vs. Desktop Publishing
5.4 WYSIWYG Feature

5.5 Graphics

5.6 Margins

5.7 Fonts

5.8 Printers

Introduction

When documents and images are printed, these are "published." Before
computers became common place, the publishing process required large print
presses that copied and duplicated pages. In order to print images and words
on the same page, the text and graphics would have to be printed separately,
cut out, placed on a single sheet, taped in place, then copied and printed.
Fortunately, computers with graphical user interfaces have enabled desktop
publishing, which allows this process to be done electronically.

5.1 Desktop publishing:

Any time we use a computer to create a printable document, it can be
considered desktop publishing. Desktop publishing programs can be used to
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create books, magazines, newspapers, flyers, pamphlets, and many other
kinds of printed documents. Word processing programs like Microsoft Word
can be used for basic desktop publishing purposes.

Complete desktop publishing involves the combination of typesetting
(choosing fonts and the text layout), graphic design, page layout (how it all fits
on the page), and printing the document. However desktop publishing can also
be as simple as typing and printing a school paper. In order to desktop publish,
all we need is a computer, monitor, printer, and software that can create a
printable document. While that might cost more than a pen and paper, it
certainly is cheaper than a printing press.

5.1.1 Definition:
Desktop publishing is the process of using a computer and specific types of
software to combine text, images and artwork to produce documents

properly formatted for print or visual consumption.
5.1.2 Desktop Publishing Opened Visual Communication To All
Desktop publishing isn't limited to professionals. With the advent of

desktop publishing software and affordable desktop computers, a wide range
of people, including non-designers and others without graphic design

experience, suddenly had the tools to become desktop publishers.
Freelance and in-house graphic designers, small business owners,

secretaries, teachers, students and individual consumers do desktop
publishing.

Non-designers can create visual communications for commercial digital
printing, printing on a printing press, and for desktop printing at home or in the

office.
Although desktop publishing encompasses everything from the initial

design to printing and delivery of the finished product, the core parts of
desktop publishing are the page_layout, text composition and the prepress or
digital file preparation tasks.
5.2 Desktop-publishing softwares

The primary software used in desktop publishing is page layout software
and web design software. Graphics software, including drawing software, a
photo editor and word processing software, are also important tools of the
graphic designer or desktop publisher. The list of available software is lengthy,
but some softwares are seen on just about everyone's must-have list depending
on what they are trying to accomplish.
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5.2.1 Page Layout Software for Printing
e Adobe InDesign
e PagePlus Series from Serif
- QuarkXpress
5.2.2 Page Layout Software for Office
-@ Microsoft Office Suite
-0 Apple iWork Suite
5.2.3 Graphics Software
-@ Adobe Illustrator
-@ Corel Draw
-0 Inkscape
5.2.4 Photo Editing Software
- Adobe Photoshop
-@ Corel PaintShop Pro
5.2.5 Web Design Software
-@ Adobe Dreamweaver CC
- Adobe Muse
5.3 Word Processing vs. Desktop Publishing

Both word processing and desktop publishing are similar in many ways
but different in areas that cover the publication of documents.
The similarities between the two are:

e. Both deal with text that can be formatted.
-0 Both can work with tables and pictures.
-® Both have many similar features like WordArt, Clip Art, and
text styles.
The differences between the two are:

Word processing involves creation, editing, and printing of text while
desktop publishing involves production of documents that combine text
with graphics.

Word processing is difficult to layout and design as compared to desktop
publishing. Thus, desktop publishing is used to work on things like
newsletters, magazines, adverts, and brochures where layout is important.
Word processing documents are common for simple memos, letters,
manuscripts, and resumes.

5.4 WYSIWYG Feature:

Pronounced WIZ-zee-wig. Short for what you see is what you get. A
WYSIWYG application is one that enables us to see on the display screen
exactly what will appear when the document is printed. A WYSIWYG is a
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system in which content (text and graphics) can be edited in a form closely
resembling its appearance when printed or displayed as a finished product,
such as a printed document, web page, or slide presentation. WYSIWYG is
especially popular for desktop publishing

With desktop publishing, we can increase productivity, minimize
production cost, enhance the appearance of our documents, improve the level
of creativity, reduce the time taken for printing and produce customized
documents. The best part about DTP is that we can create professional-looking
documents, without the need for graphic designer.

5.5 Graphics

A graphic is an image or visual representation of an object. Therefore,
computer graphics are simply images displayed on a computer screen.
Graphics are often contrasted with text, which is comprised of characters,
such as numbers and letters, rather than images.

Computer graphics can be either two or three-dimensional. Early
computers only supported 2D monochrome graphics, meaning they were black
and white (or black and green, depending on the monitor). Eventually,
computers began to support color images. While the first machines only
supported 16 or 256 colors, most computers can now display graphics in
millions of colors.

There are two main types of 2D graphic:

;@ Bitmap or Raster graphics

-0 Vector graphics
5.5.1 Bitmap or raster graphics

Bitmap graphics consist of many tiny dots called pixels. It is possible to
edit each individual pixel using bitmap graphics software like Adobe
Photoshop .

Examples of bitmap graphics are a digital photograph or a scanned image.

The amount of detail we can draw depends on the number of pixels per
square inch (PSI). Since the computer has to store information about every
single pixel in the image, the file size of a bitmap graphic is often quite large.
When we resize a bitmap graphic, it tends to lose its quality.

5.5.2 Vector graphics

Vector graphics are based on control points which are connected by lines and
curves called vector paths or vectors. Vector paths can be used to make shape
objects. It is possible to edit each shape object separately, for example, to
change the shape, outline type (stroke), fill, size or position.
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Vector graphics software includes Adobe Illustrator and CorelDRAW.

When a vector graphic is resized, it doesn't lose quality. This is because the
software works out the new relationships between control points and redraws
the image at the new size. Vector graphics do not store information about each
pixel so file size does not depend on image size. Instead it depends on how
much detail is in the image.

25 100 25 %001
pixels pixels pixels pixels

Fig. 5.1

Top Margi
3D graphics started to become popular op Viargin

in the 1990s, along with 3D rendering
software such as CAD and 3D animation
programs. By the year 2000, many video
games had begun incorporating 3D Print Space
graphics, since computers had enough
processing power to support them. Now
most computers now come with a 3D
video card that handles all the 3D
processing. This allows even basic home
systems to support advanced 3D games
and applications.

Left Margin
widae Y3y

5.6 Margins

A margin is the area between the
main content of a page and the page
edges. The margin helps to define where
a line of text begins and ends. A page to
include top, Bottom, Left and Right
margin as shown in fig 5.2. Fig. 5.2

Bottom Margin
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The default margins are usually defined as one inch on all sides. However,
depending on the requirement, the margins may vary. These margins create a
frame around the content of the page so that the text does not run all the way
to the edges. The white space along the edges of the document makes the page
look cleaner and the text is easier to read.

Fig. 5.3 Fig. 5.4

5.6.1 Gutter position

A gutter margin setting adds extra space to the side margin or top margin
of a document that we plan to bind. A gutter margin helps ensure that text isn't
hidden by the binding.

5.7 Fonts

A font is a set of printable or displayable text character s in a specific style
and size or we can say that a font is a specific typeface of a certain size and style. A
typeface is a set of characters of the same design. These characters include
letters, numbers, punctuation marks, and symbols. Some popular typefaces
include Arial, Helvetica, Times, and Verdana. While most computers come with a
few dozen typefaces installed, there are thousands of typefaces available. Because
they are vector-based (not bitmaps), typefaces can be scaled very large and still
look sharp. The term "typeface" is often confused with "font," which is a specific
size and style of a typeface. For example, Verdana is a typeface, while Verdana 10
ptbold is a font. It's a small difference, but is good to know.
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Arial

Arial Regular Avrial Narrow Regular
Arial Italic Arial Narrow ltalic
Arial Bold Arial Narrow Bold

Arial Bold Italic Arial Narrow Bold Italic

Arial Black Arial Rounded MT Bold

Fig. 5.5

5.8 Printer

A printer is an external output device that takes data from a computer and
generates output on a paper in the form of graphics / text.
There are two types of printers.

Impact Printers

Non-Impact Printers

5.8.1 Impact printers

An impact printer has a head that contains pins to make contact with the
paper. It usually forms the print image by striking its pins on a inked ribbon
against the paper . Following are some examples of impact printers.
5.8.1.1 Dot-Matrix Printers

The dot-matrix printer uses print heads containing from 9 to 24 pins. These
pins produce patterns of dots on the paper to form the individual characters. The
24 pin dot-matrix printer produces more dots that a 9 pin dot-matrix printer,
which results in much better quality and clearer characters. The general rule is:
the more pins, the clearer the letters on the paper. The pins strike the ribbon
individually as the print mechanism moves across the entire print line in both
directions, i-e, from left to right, then right to left, and so on. The user can produce
a color output with a dot-matrix printer (the user will change the black ribbon with
aribbon that has color stripes). Dot-matrix printers are inexpensive and typically
print at speeds of 100-600 characters per second.
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Fig 5.6 Dot Matrix Printer

5.8.1.2 Daisy-wheel Printers

In order to get the quality of type found on typewriters, a daisy-wheel impact
printer can be used. It is called daisy-wheel printer because the print mechanism
looks like a daisy; at the end of each “Petal” is a fully formed character which
produces solid-line print. A hammer strikes a “petal” containing a character
against the ribbon, and the character prints on the paper. Its speed is slow
typically 25-55 characters per second.

Fig 5.7 Daisy Wheel Printer

Note:

dot marix printer and daisy wheel printer comes in the category of
character- at- a- time printer.

5.8.1.3 Line Printers

In business where enormous amount of material are printed, the character-at-
a-time printers are too slow; therefore, these users need line-at-a-time
printers. Line printers, or line-at-a-time printers, use special mechanism that
can print a whole line at once; it can typically print the range of 1,200 to 6,000
lines per minute. Drum, chain, and band printers are line-at-a-time printers.
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Fig 5.8
5.8.2 Non-Impact Printers
Non-impact printers do not use a striking device to produce characters on the
paper; and because these printers do not strike hammer against the paper its much
quieter. Following are some non-impacted printers.

5.8.2.1 Ink-jet printers

Ink-jet printers work in the same fashion as dot-matrix printers in the form
images or characters with little dots. However, the dots are formed by tiny droplets
of ink. Ink-jet printers form characters on paper by spraying ink from tiny nozzles
through an electrical field that arranges the charged ink particles into characters
at the rate of approximately 250 characters per second. The ink is absorbed into
the paper and dries instantly. Various colors of ink can also be used.

Fig 5.9
One or more nozzles in the print head emit a steady stream of ink drops.
Droplets of ink are electrically charged after leaving the nozzle. The droplets
are then guided to the paper by electrically charged deflecting plates [one plate
has positive charge (upper plate) and the other has negative charge (lower
plate)]. A nozzle for black ink may be all that's needed to print text, but full-
color printing is also possible with the addition of needed to print text, three
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extra nozzles for the cyan, magenta, and yellow primary colors. If a droplet
isn't needed for the character or image being formed, it is recycled back to its
input nozzle.

Several manufacturers produce color ink-jet printer. Some of these
printers come with all their color inks in a cartridge; if we want to replace on
color, we must replace all the colors. Other color ink-jet printers allow us to
replace ink individually. These printers are a better choice if user uses one
color more than other colors. These printers produce less noise and print in
better quality with greater speed.

5.8.2.2 Laser printers

Alaser printer works like a photocopy machine. Laser printers produce
images on paper by directing a laser beam at a mirror which again directs the
beam onto a drum. The drum has a special coating on it to which toner (an
ink powder) sticks. Using patterns of small dots, a laser beam conveys
information from the computer to a positively charged drum to become
neutralized. From all those areas of drum which become neutralized, the
toner detaches. As the paper rolls by the drum, the toner is transferred to the
paper printing the letters or other graphics on the paper. A hot roller bonds
the toner to the paper.

Fig 5.10

Laser printers use buffers that store an entire page at a time. When a
whole page is loaded, it will be printed. The speed of laser printers is high and it
prints quietly without producing much noise. Many home-use laser printers can
print eight pages per minute, but faster printer can print approximately 21,000
lines per minute, or 437 pages per minute (if each page contains 48 lines). When
high speed laser printers were introduced they were expensive. Developments in
thelast few years have provided relatively low-cost laser printers for use in small
businesses.
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oint member

1. In order to desktop publish; all we need is a computer, monitor,
printer, and software that can create a printable document.

2. Desktop publishing hardware and software are also used to design and
produce web pages.

3. The primary software used in desktop publishing is page_layout
software and web design software.

4. Both word processing and desktop publishing are similar in many

ways but different in areas that cover the publication of documents.

A graphic is an image or visual representation of an object.

A margin is the area between the main content of a page and the page

edges.

7. A printer is an external output device that takes data from a computer
and generates output in the form of graphics / text on a paper

o o1

Exe rC|Se 4) is a visual representation of

objects
1. Multiple Choice Questions: a. Charts
1) Programs that can be used to create b. Graphics
books, magazines, newspapers, flyers, c. Frames
pamphlets, and many other kinds of d. Fonts
printed documents. 5) Printer that print image by pressing an
a. Desk Publishing inked ribbon against the paper using a
b. Desk Top Publishing hammer or pins.
c. Top Publishing a. Ink-jet
d. Publishing b. Impact
2) That enables us to see on the display c. Nonimpact
screen exactly what will appear when the d. Laser
document is printed.
a. WYSWJKI Fill in the banks
b. WKSWUG
c. WUSIWUG 1) Arial, Helvetica, Times, and
d. WYSIWYG Verdana etc. are examples of,
3) A printer that works like a photocopy and they have same .
machine 2) A Gutter margin setting adds
a. Laser extra space to the ____ margin or
b. InkdJet _____ margin of a document that
c. Line we plan to bind.
d. Drum
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3) In web pages the content is
, not designed for _____

4) Laser printers use that

stores an at a time.
True/False

1) DTP stands for Desk Top
Publishing.

2) Desktop publishing hardware and
software is also used to design and
produce web pages.

3) In Ink-Jet Printer, the ink can
be absorbed into the paper and
dries instantly.

4) The dot-matrix printer uses print
heads containing from 19 to 124
pins.

Very short Answers Type Questions

1) Which printer can typically print
the range of 1,200 to 6,000 lines
per minute?

2) Which image can be either two or
three-dimensional.

3) Which printer has a special coating
on it to which toner (an ink
powder) sticks?

4) A set of characters of the same
designis called as .....?

5) The area between the main

content of a page and the page
edges is called as ....?

Short Answer type Questions

1) What is Desktop Publishing?

2) What are the various types of

printers?

3) What is margin?
4) What do you mean by Gutter

Position?

5) What are Graphics?
6) Explain WYSIWYG feature.
Long Answer type questions

1) What is the difference between
Vector Graphics and Bitmap
Graphics?

2) Describe Desktop Publishing &

List any five software used for
Desktop Publishing.

3) What is the difference between

Impact and Non-Impact printers?

4) What are non-impact printers

explain laser & inkjet printers.

Answers Key

m Multiple Choice Fill inthe Blanks Very Short Answer

- Desk Top Typeface, design
Publishing

— WYSIWYG  Side, top

— Laser Viewable, print

n Graphics Buffers, entire page

- Impact -
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.True Computer Graphics
.True Laser Printers
False Typeface

- Margins



Chfgter OPERATING SYSTEM

Objectives of this chapter:

6.1 Definition of operating system

6.2 Types of operating systems

6.3 Difference between DOS and Windows Operating System
6.4 Linux

6.5 Computer Security

Introduction:
An Operating System (OS) is an interface between computer user and

computer hardware. An operating system is software which performs all the
basic tasks like file management, memory management, process
management, handling input and output, and controlling peripheral devices

such as disk drives and printers.
Some popular Operating Systems include Linux, Windows, OS X, VMS,

0S/400, AIX, z/OS, etc.

6.1 Definition of operating system
An operating system is a program that acts as an interface between the

user and the computer hardware and controls the execution of all kinds of
programs.

Fig 6.1 Operating System
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6.1.1Services provided by operating System

An Operating System provides services to both the users and to the
programs.

° It provides programs an environment to execute program.
o It provides tousers the services to execute the programs in a
convenient manner.
Following are a few common services provided by an operating system
Program execution
I/O operations
File System manipulation
Communication
Error Detection
Resource Allocation
° Protection

6.1.1.1 Program execution

Operating systems handle many kinds of activities from user
programs to system programs like printer spooler, name servers, file server,
etc. Each of these activities is encapsulated as a process.

A process includes the complete execution context (code to execute,
data to manipulate, registers, OS resources in use). Following are the major
activities of an operating system with respect to program management

o Loads a program into memory.

Executes the program.

Handles program's execution.

Provides a mechanism for process synchronization.
Provides a mechanism for process communication.
° Provides a mechanism for deadlock handling.

6.1.1.2 I/0 Operation

An I/0 subsystem comprises of I/O devices and their corresponding
driver software. Drivers hide the peculiarities of specific hardware devices
from the users.

An Operating System manages the communication between user
and device drivers.

e [/O operation means read or write operation with any file or any

specific I/O device.

e Operating system provides the access to the required 1/0O device
when required.
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6.1.1.3 File system manipulation

File manipulation refers to wide variety of operations which are available
and allow us to delete ,copy, move. As we know a file represents a collection of
related information. Computers can store files on the disk (secondary storage),
for long-term storage purpose. Examples of storage media include magnetic
tape, magnetic disk and optical disk drives like CD, DVD. Each of these media
has its own properties like speed, capacity, data transfer rate and data access
methods.

A file system is normally organized into directories for easy navigation
and usage. These directories may contain files and other directions. Following
are the major activities of an operating system with respect to file
management

° Program needs to read a file or write a file.

° The operating system gives the permission to the program for
operation on file.

o Permission varies from read-only, read-write, denied and so on.

° Operating System provides an interface to the user to
create/delete files.

° Operating System provides an interface to the user to
create/delete directories.

o Operating System provides an interface to create the backup of file
system.

6.1.1.4 Communication
In case of distributed systems which are a collection of processors that

do not share memory, peripheral devices, or a clock, the operating system
manages communications between all the processes. Multiple processes

communicate with one another through communication lines in the network.
The OS handles routing and connection strategies, and the problems of

contention and security. Following are the major activities of an operating

system with respect to communication
e Two processes often require data to be transferred between them
e Both the processes can be on one computer or on different
computers, but are connected through a computer network.
e Communication may be implemented by two methods, either by

Shared Memory or by Message Passing.
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6.1.1.5 Error Detection

Errors can occur anytime and anywhere. An error may occur in CPU, in
I/0 devices or in the memory hardware. Following are the major activities of an
operating system with respect to error Detection

° The OS constantly checks for possible errors.

° The OS takes an appropriate action to ensure correct and

consistent computing.

6.1.1.6 Resource Management

In case of multi-user or multi-tasking environment, resources such as
main memory, CPU cycles and files storage are to be allocated to each user or
job. Following are the major activities of an operating system with respect to
resource management

o It acts like a resource manager. The OS manages all kinds of
resources using schedulers.

o CPU scheduling algorithms are used for better utilization of
CPU.

6.1.1.7 Protection

Considering a computer system having multiple users and concurrent
execution of multiple processes, the various processes must be protected from
each other's activities.

Protection refers to a mechanism or a way to control the access of
programs, processes, or users to the resources defined by a computer system.
Following are the major activities of an operating system with respect to

protection
o The OS ensures that all access to system resources is
controlled.
° The OS ensures that external I/O devices are protected from
invalid access attempts.
o The OS provides authentication features for each user by means
of passwords.

6.2 Types of Operating Systems

Operating systems are there from the very first computer generation
and it keep evolving with time. In this chapter, we will discuss some of the
important types of operating systems which are most commonly used.

6.2.1 Batch operating system
The users of a batch operating system do not interact with the computer

directly. Each user prepares his job on an off-line device like punch cards and
submits it to the computer operator. To speed up processing, jobs with similar
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needs are batched together and run as a group. The programmers leave their
programs with the operator and the operator then sorts the programs with

similar requirements into batches.
The problems with Batch Systems are as follows
° Lack of interaction between the user and the job.
° CPU is often idle, because the speed of the mechanical I/0O

devices is slower than the CPU.
° Difficult to provide the desired priority.

6.2.2 Time-sharing operating systems

Time-sharing is a technique which enables many people, located at
various terminals, to use a particular computer system at the same time.
Time-sharing or multitasking is a logical extension of multiprogramming.
Multiple jobs are executed by the CPU by switching between them, but the
switches occur so frequently. Thus, the user can receive an immediate
response. Computer systems that were designed primarily as batch systems
have been modified to time-sharing systems. Advantages of Timesharing
operating systems are as follows

° Provides the advantage of quick response.

° Avoids duplication of software.

° Reduces CPU idle time.

Disadvantages of Time-sharing operating systems are as follows ?

° Problem of reliability.

° Question of security and integrity of user programs and data.

° Problem of data communication.

6.2.3 Distributed operating System

Distributed systems use multiple central processors to serve multiple
real-time applications and multiple users. Data processing jobs are
distributed among the processors accordingly.

The processors communicate with one another through various
communication lines (such as high-speed buses or telephone lines). These are
referred as loosely coupled systems or distributed systems. Processors in a
distributed system may vary in size and function. These processors are
referred as sites, nodes, computers, and so on.

The advantages of distributed systems are as follows

° With resource sharing facility, a user at one site may be able to
use the resources available at another.
° Speedup the exchange of data with one another via electronic
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mail.

° If one site fails in a distributed system, the remaining sites can
potentially continue operating.

° Better service to the customers.

° Reduction of the load on the host computer.

° Reduction of delays in data processing.

6.2.4 Network operating System

A Network Operating System runs on a server and provides the server the
capability to manage data, users, groups, security, applications, and other
networking functions. The primary purpose of the network operating system is
to allow shared file and printer access among multiple computers in a network,
typically a local area network (LAN), a private network or to other networks.

Examples of network operating systems include Microsoft Windows
Server 2003, Microsoft Windows Server 2008, UNIX, Linux, Mac OS X, Novell
NetWare, and BSD.

The advantages of network operating systems are as follows

e Centralized servers are highly stable.

e Security is server managed.

e Upgrades to new technologies and hardware can be easily

integrated into the system.
e Remote access to servers is possible from different locations and
types of systems.

The disadvantages of network operating systems are as follows

e High cost of buying and running a server.

e Dependency on a central location(server) for most operations.

e Regular maintenance and updates are required.

6.2.5 Real Time operating System

A real-time system is defined as a data processing system in which the
time interval required to process and respond to inputs is so small that it
controls the environment. The time taken by the system to respond to an input
and display of required updated information is termed as the response time. So
in this method, the response time is very less as compared to online
processing.

Real-time systems are used when there are rigid time requirements on
the operation of a processor or the flow of data. A real-time operating system
must have well-defined, fixed time constraints, otherwise the system will fail.
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For example, Scientific experiments, medical imaging systems, industrial
control systems, weapon systems, robots, air traffic control systems, etc.

6.3 Difference between DOS And Windows Operating System

Disk Operating System abbreviated as DOS is a product of Microsoft
Corporation released in 1981 and it comes as part-and-parcel with Microsoft
Windows operating system.To get to DOS prompt and give commands for
performing tasks on files and directories,

Click Start > Run... and type command or cmd and press ENTER.

Windows is a series of most popular operating systems developed by
Microsoft for use on personal computers. First edition of Windows that runs
on MS-DOS 5.0 was released in 1985, as a 16-bit OS. Of all the editions of
Windows OS released by Microsoft Corporation from 1985 till date, the
popular ones include Windows 98, Windows 2000 Professional, Windows XP,
Windows Vista and Windows 7,Windows8,Windowsl0 Coming to differences,
here are 5 basic ones that differentiate DOS and Windows:

DOS Windows
Single user Multi User
Single tasking Multi tasking
Not time Sharing Time sharing
Input device keyboard Standard Input devices are keyboard and mouse
Character User Interface
(CUD Graphical User Interface (GUI)
6.4 Linux

Linux is one of popular version of UNIX operating System. It is open source
as its source code is freely available. It is free to use. Linux was designed
considering UNIX compatibility. Its functionality list is quite similar to that
of UNIX.
6.4.1 Basic Features

Following are some of the important features of Linux Operating
System.

° Portable : Portability means software can works on different
types of hardware in same way. Linux kernel and application
programs supports their installation on any kind of hardware
platform.
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° Open Source : Linux source code is freely available and it is
community based development project. Multiple teams work in
collaboration to enhance the capability of Linux operating system
and it is continuously evolving.

° Multi-User : Linux is a multiuser system means multiple users can
access system resources like memory/ ram/ application programs
at same time.

° Multiprogramming : Linux is a multiprogramming system means

multiple applications can run at same time.

o Hierarchical File System : Linux provides a standard file structure
in which system files/ user files are arranged. Files and directories
are arranged in tree structure form

° Shell : Linux provides a special interpreter program which can be
used to execute commands of the operating system. It can be used
to do various types of operations, call application programs. etc.

° Security : Linux provides user security using authentication
features like password protection/ controlled access to specific
files/ encryption of data.

6.5 Computer Security

Computer security is the process of preventing and detecting unauthorized
use of our computer. Prevention measures help us to stop unauthorized users
(hackers) from accessing any part of our computer system. Detection helps us to
determine whether or not someone attempted to break into our system, if they
were successful, and what they may have done.

Our computers have become an extension of everything we do from
banking and investing to shopping and communicating with others through
email or chat. We may not consider our communications "top secret," most likely
we do not want strangers reading our email, using our computer to attack other
systems, sending forged email from our computer, or examining personal
information stored on our computer.

Hackers do not care about our identity. Often they want to gain control of
our computer so they can use it to launch attacks on other computer systems.
Having control of our computer gives the hackers the ability to hide their actual
location as they launch attacks, often against high-profile computer systems
such as government or financial systems.

Hackers have the ability to watch all our actions on the computer, or cause
damage to our computer by reformatting our hard drive or changing our data.
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Internet Security is the most important aspect that everyone using the
internet should understand. Here we are describing a few important tips to keep
ourself secure and protect our Information from Security threats.

6.5.1 Latest Anti-virus software:

New viruses and threats are being discovered everyday and to cope with
that we need to have a latest version of the Anti-virus software. Even to make our
Version of Anti- Virus software effective, we need to update it with latest updates
available. There are many Anti- Virus Software available, both free and paid.

6.5.2 Anti-Spyware Software:

Anti-virus software alone is not enough. To be secure from Internet
Security threats we also need Anti-spyware software. Spyware programs are
different from viruses in a way that unlike virus it does not alter the way in which
our machines works or corrupt any data but it installs itself on our machine to
send important data like passwords, Credit card numbers stored on your
machine to its server. So in order to detect spyware programs & prevent one from
getting into our machine we need latest Anti-spyware software.

6.5.3 Password protection:

Passwords are the most important aspect of various online accounts. They
provide access to online accounts and enable us to perform various activities
linked with account like shopping, emailing, online transactions etc. Keeping our
password secure is like keeping money secure. Never keep same passwords for
different accounts. Never keep password's that can be guessed or password
relating to our personal's like telephone number, date of birth etc. Use long
Password's consisting of both letters and digits and may be some special
characters. Always Access Websites Related to our password directly by opening a
new webpage and never through a link in email or provided otherwise.

6.5.4 Apply Latest Updates & Patches:

No software installed on our system is perfect for life. Apply the latest
updates & patches to the software. These updates and patches are made available
from time to time by the software manufacturer.

6.5.5 Firewall:

If possible try to Use a firewall to prevent hackers from attacking our
system. Firewall blocks traffic not authorized to access our PC. Firewall enables
us to access internet securely and prevent unauthorized applications and people
from accessing our PC.
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oints emember

An operating system is a program that acts as an interface between the user and the
computer hardware.

2. Operating systems handle many kinds of activities from user programs to system
programs like printer spooler, name servers, file server, etc. Each of these activities
is encapsulated as a process.

3. Afile represents a collection of related information. Computers can store files on the
disk (secondary storage), for long-term storage purpose.

4. Time-sharing is a technique which enables many people, located at various
terminals, to use a particular computer system at the same time.

5. Real-time systems are used when there are rigid time requirements on the operation
of a processor.

6. Linux is one of popular version of UNIX operating System. It is open source as its
source code is freely available.

7.

Computer security is the process of preventing and detecting unauthorized use of

our computer.

Exercise

1. Multiple Choice Questions:

1) An operating system is a
a. Terminal
b. Software
c. Storage system
d. Processor
2) The process of running multiple
applications at the same time is known
as
Multi application
Multi processing
Multi programming
Multi timing
3) It enables us to access internet securely
and prevent unauthorized applications
and people from accessing our PC.
a. Anti-Virus
b. Security
c. Firewall
d. None of these

Qoo

4) The time taken by the system to respond
to an input and display of required
updated information is

a. Response time
b. Access time
c¢. Output time
d. Total time
5) Remote access to servers is possible
from different locations in .
a. Batch Processing System
b. Time Sharing System
c. Network Operating System
d. Distributed system
2. Fill in the Blanks.
represents a collection of

System wuse multiple
_____ processors to serve
multiple real-time applications and

multiple users.

3) is the process of preventing
and detecting use of
our computer.

4) provide access to

accounts and enable us to perform
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various activities linked with account
like shopping, emailing, online 2)
transactions etc.

5) are used when there
are time requirements on 3)
the operation of a processor or the
flow of data.

3. True/False

1) The time taken by the system to 4)
respond to an input and display of
required updated information is
termed as the response time.

What hides the peculiarities of
specific hardware devices from the
users.

A mechanism or a way to control
the access of programs, processes,
or users to the resources defined by
a computer system is called as......

The process of preventing and
detecting unauthorized use of our
computer is called as......

2) Anti-virus software alone is enough 5. Short answer type Questions:

to be secure from Internet Security 1)
threats. 2)
3) An Operating System cannot 3)
manage the communication between 4)
user and device drivers.
4) Linux source code is freely available 5)

and it is community based

Whatis an operating System?

List type of operating systems.
Explain real time operating system.
What are the functions of operating
system? Make a list.

What do you mean by computer
security?

development project. 6. Long Answer Type Questions:

5) The OS manages all kinds of 1)
resources using schedulers.
4. Very short Answers type questions: 2)

1) An interface between computer user
and computer hardware is call

Answers Key

Software File, Information

Multi Distributed, Central
programming
Firewall Computer
Security,Unauthorized
Response Time Passwords, Online
Network Real Time Systems,
Operating System Rigid
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Explain functions of operating
system.
What are the basic features of Linux?

Multiple Choice Fill in the Blanks Very Short Answer

Operating System
False Drivers
False Protection
True Computer Security

True



Chapter

Microsoft Publisher - | 7

Objectives of this chapter:

7.1 WhatisPublisher?

7.2 Microsoft Publisher 2010
7.3 How to start publisher?
7.4 Creating a Publication
7.5 Frames

7.6 Viewing Pages Templates
7.7 Templates

7.8 Saving Your Publication

7.9 Printing Your Publication

7.1 What is Publisher?

Publisher is an application used to design and produce attractive
advertising and promotional material like pamphlets, letter heads, banners,
posters, calendars, invitations, and newsletters and so on. This advertising
and promotional material is called a publication.

Publisher enables us to produce quick publications by using wizards and
a design gallery. A template is the predefined model of publication. We can view
the publication on the monitor exactly the way it would appear when printed.
Publisher also helps us keep track of the colors used in publications to produce
high-quality color output. With the help of publisher, we can create quick web
sites at a minimum cost with ease.

7.2 Microsoft Publisher 2010:

Publisher 2010 is a program that helps us design professional
publications such as newsletters, websites, brochures, catalogs, flyers, signs,
postcards, invitations, greeting and business cards, letterheads, envelopes,
business forms, banners, calendars, certificates, and more. Microsoft
Publisher 2010 helps us to create professional-looking publications quickly and
easily. With Publisher, we can create, design, and publish professional
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marketing and communication materials for print, and for e mail. Publisher
2010 allows us to apply built-in templates, to apply our own custom templates,
and to search from a variety of templates available on Office.com. Office.com
provides a wide selection of popular Publisher templates, including
newsletters and flyers.

7.3 How to start publisher?

Follow the given steps to start Publisher:
On the Start menu, point to All Programs, point to Microsoft office, and then
click Microsoft office publisher 2010.

Fig 7.1
1. Click on the start button.
2. The search bar is shown in start menu for searching the programs and
files.
Fig 7.2
3. Type "Publisher" or "Pub" in search bar and press enter button.

Fig 7.3 Search Bar
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Fig 7.4 Publisher opening window

7.4 Creating a Publication
We can create new Publication by following methods:
1. By using Blank Layout.
2. By using Installed templates.
3. By using online templates.

7.4.1 Creating a publication using blank Layout:
Following are the steps to start with a blank publication.
1. Click the File Menu, and then click New.

2. Under Available Templates, click a blank publication template,
and then click Create.

Note:

We can choose the desired size of blank template by clicking More
Blank Page Sizes from the New Publication screen or even we can also
customize the size as per our requirement. Here we have selected Blank
8.5x 11 (either Landscape or Portrait).

Fig 7.5
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3. Now, we can create a publication with our own specifications in
Publication. We can also add the objects to the blank Layout like text, picture,
word art, and auto shapes etc. The blank layout window is shown as below:

Fig 7.6 Blank Publication window

4. After creating publication, save the publication by clicking on save
option in File Menu. The Save As dialog box appears. type a name for our
publication, select the folder in which we want to save it, and then click save
button. The publication is saved with a .pub extension.

5. Close the publication by clicking close button in File menu. A dialog
box appears, if we want to save the changes, then click yes button, otherwise
click no.

Before exiting Publisher, we should close all the publications, then Click Exit
in File Menu or click cross button on title bar.

7.4.2 Components of publisher window
There are three most important components that we should remember as we
work within Publisher 2010. These are:

7.4.2.1 The Quick Access Toolbar

7.4.2.2 The Ribbon

7.4.2.3 The File Window.

7.4.2.1 Quick Access Toolbar

The quick access toolbar is a customizable toolbar that contains
commands that we may want to use. We can place the quick access toolbar
above or below the ribbon. To change the location of the quick access toolbar,
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click on the arrow at the end of the toolbar and click Show below the Ribbon. We
can also add items to the quick access toolbar, simply click on any item and it
will be added to our toolbar.

Fig. 7.7 Customize Quick Access Toolbar

7.4.2.2 Ribbon

The ribbon is the panel at the top portion of the document it has six tabs:
Home, Insert, Page Design, Mailings, Review, and View. Each tab is divided into
groups

Fig 7.8 Ribbon of Publisher

7.4.2.3 File Window

When we click on the File Menu, we are brought to the Info screen. It
looks like that our document is gone, but it is not. As we click on the options
in the File Menu, the screen will change accordingly.
° Save: Save the file as a 2010 file
Save As: Allows you to choose a different file type (i.e. PDF, Word)
Open: used to open a publisher file
Close: Closes the file but keeps Publisher running
Info: Edit Business Information, use Design Checker, and set Commercial
Print Information
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Recent: List of our recently used Publisher files

New: New Publication Screen

Print: Print Options

Save & Send: Options for saving and e-mailing the file
Help: Microsoft Help

Options: Set default options

Exit: Closes Publisher (file and program)

Fig 7.9 File Window

7.4.3 Working in publication:

7.4.3.1

1.
2.
3

4.

Adding Text:

From the Home or Insert Tab, select Draw Text Box.

Place the cursor on the page where we want to draw a text box.
Click and drag the cursor across the page to the desired size. The
size of the text box can be changed after we have drawn it.

When we let go of the left click on the mouse, we are brought to
the format tab which gives us more options for the text box.

Type the text in text box.

Fig. 7.10
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7.4.3.2

7.4.3.1
steps:

7.4.3.4

Editing Text:

Highlight the text we want to edit.

If we are not brought to the Text Box Tools Format Tab, then

select it.

Text Group Options:

a. Text Fit - Defines how the text will fit in the text box: Best
Fit, Shrink Text on Overflow, Grow Text Box to Fit, Do Not

Auto-Fit
b. Text Direction - Changes direction to horizontal or vertical
C. Hyphenation - Changes hyphenation behavior of selected
text.

Font Group Options: Style, Font Size, Bold, Italics, Underline,
Text Spacing, & Color

Alignment Group Options: Text Box Alignment, Columns,
Margins

Effects Group Options: Shadow, Outline, Engrave, Emboss

Fig. 7.11

Changing the Text Box Style: To change the text box style follow the

Click on the text box.
Click on the Drawing Tools Format Tab.

Shape Styles Group Options: Style, Shape Fill, Shape Outline,
Change Shape

Arrange Group Options: Wrap Text, Bring Forward or Backward,
Rotate

Fig. 7.12

Inserting Clip Art: To insert the clip Art follow the steps:
Click on the Insert Tab.
Click Clip Art. The Clip Art window appears on the right side of

the screen.
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7.4.3.5

Type in a keyword.

Click Go.

Browse through the results.

When we find clip Art, click on the thumbnail from the Clip Art

Window.
The Clip Art image will then appear on our page.

Fig. 7.13

Inserting a Picture: To insert a picture follow the steps:
Click on the Home or Insert tab.
Click on Picture.

Browse to the location of the picture we have saved on our
computer.

Select the picture and click Insert.

Fig. 7.14

7.4.3.6 Inserting Shapes: To insert a shape follow the steps:

Ol N =

2

Click on the Home or Insert tab.

Click on Shapes.

Select a shape from the drop down menu.

On the page, click and drag to create the shape.

The shape appears on the page, and we are brought to the Drawing
Tools

Format tab. From this tab, we can edit the style, fill, outline, and more.
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Fig. 7.15

7.4.3.7 Text Wrapping: Text wrapping is the way our object is set on the
page in reference to the text. To do text wrapping following are the steps:
1. Select the Object.
2. Click on the Format tab (Text Box, Drawing, or Picture Format).
3. In the Arrange group, click on Wrap Text. This will determine how
text will be arranged around the object.

Here are the Options: None, Top & Bottom, Square, Through, Tight,
More Layout Options

Fig. 7.16
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7.4.3.8 Resizing Objects: Resizing enables us to resize our objects.
1. Click on the object.
2. Click and drag the handles to resize.
a.The corner handles will resize the object proportionally.
b.The handles centered on the lines of the box will stretch the
object vertically and horizontally.
The green handle allows us to rotate the object.

Fig 7.17
7.4.3.9 Moving Objects:

1. Click on the object.

2. Place our cursor over the solid line so that we see the
crosshairs.

3. Click and drag the object to the desired location.

Fig 7.18

7.4.3.10 Deleting Objects: We can also delete any object, if do not
require it in our publication.

1. Click on the object.

2. Press Delete button on the keyboard.

7.5 Frame-

Most publications are divided into several different areas called frames.
A frame can contain a variety of objects such as graphics, tables, or text
boxes. Frames can be resized, moved and manipulated to suit your needs.

7.5.1 Working with Frames

Each publication is composed of different frames, such as text frames,
picture frames, table frames, and shape/object frames. Click on different
areas of the publication to identify the different frames. Handles, little circles
on the corners and sides of the frame will appear. The handles help us to show
which frame we have selected. These are also used in resizing frames.

Handles - When we click on a frame, small circles appear around the
edge of the frame. These are called handles. We can click and drag on the
handles to resize our frame.
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7.5.2 Moving Frames:

7.5.2.1 To move a picture frame,
1. Click on the picture.
2. When our cursor turns into a four directional arrow, click and

drag the picture frame to the desired location.
7.5.2.2 To move a text frame:
1. Click on the text frame.
2. Rest our cursor near the border of the text frame. When our
cursor turns into a four directional arrow, click and drag the
text frame to the desired location.

< >
Fig. 7.19
7.5.3 Resizing Frames:
7.5.3.1 To resize a picture frame:
1. Click on the picture.
2. Rest our cursor on a corner handle. When our cursor turns

into a diagonal line with arrows on the ends, click and drag
inwards at a diagonal to make it smaller or outwards at a
diagonal to make it larger. Using corner handles to resize
pictures allows us to keep the picture in proportion.

7.5.3.1 To resize a text frame:
1. Click on the text frame.
2. Rest your cursor on one of the handles. When your cursor turns

into a line with arrows on the ends, click and drag inwards or
outwards to resize the text area.

S | N\

Resizing Arrows
Fig. 7.20
7.5.4 Deleting Frames:

1. Right click on the frame that we would like to delete.
2. Select Delete Object from the list of choices.

7.5.5 Inserting Additional Text Frames :

Click on Text box from the Insert Tab

Click and drag over an area of the publication.
Type the text we want to appear.
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7.6 Viewing Pages in our Publication : There are three ways to view pages in

a publication:
e Click on the thumbnails of the pages in the publication from the Page

Navigation Window on the left hand side of the screen.

Fig 7.21 Page navigation view

° From the View tab, we can switch from single page to two-page
spread view as well as choose other viewing options.

Fig 7.22

° On the bottom right corner of Publisher, we can change our view as
well as zoom in and out using the slider.

Fig 7.23 Zoom in Zoom out slider

7.7 Template : A Template is a tool used in Publisher to help us to easily create
basic publications. The template has a set of pre designed styles that we can use

asitis or customize as we see fit.

7.7.1 Customizing the Template: Here we will learn how to customize a
Template. Choose the publication type that we would like to use. The next
screen will show us templates for the publication we have chosen.
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Fig 7.24 Templates

Each template is customizable. Click on a template from the center. On the
right side of the screen, we can change the template colors, fonts, and more.
Once we have found a template and customized it, click Create. After we click
create, we can edit the text boxes, images, and shapes that have been set up by
the template as needed.

7.7.1.1 Changing the Design of a Template: To change the design
template follow steps:
1. Click on the Page Design tab.
2. To change the entire template, click Change Template.

° Choose a template from the pop up window. If we
are currently working in a template and changing
to a different template, the information we have
entered will conform to the new template.

3. To change the color scheme, browse through the color
schemes available in the Schemes group.
° Move the mouse over the color scheme to
preview.
° To select a color scheme, click on it.
4. To change the font scheme, click on Fonts in the
Schemes group.
° Browse through the available font schemes.
° Move the mouse over the font scheme to
preview.
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° To select a font scheme, click on it.
° If we want to create our own font scheme, click on

“New Print Scheme.’

Fig. 7.25

7.7.1 Page Design:

Click the tab Page Design if needed, to change templates, adjust page
margins, apply ruler guides, or apply built-in color schemes to the
chosen template.

We can use the Built-in Ruler Guide templates to help in aligning text
boxes, pictures, or other objects. To apply a Built-in Ruler Guide
template click on the command Guides in the group Layout, and then
choose a template.

To add a vertical or horizontal ruler guide repeat the above step, then
click on Add Vertical or Horizontal Ruler Guide.

To add additional guides, move the mouse pointer over the vertical or
horizontal ruler; drag the guide in the desired direction when the
pointer changes to a two headed arrow.

7.7.2 Creating a Publication with Templates:
We can create a publication in Publisher by using template.
Available Publication Types: Publisher 2010 allows us:

To apply built-in templates,

To apply our own custom templates, and

To search from a variety of templates available on Office.com.
Office.com provides a wide selection of popular Publisher templates,
including newsletters and flyers. To find and apply a template in
Publisher 2010, do the following:

1. On the File tab, click New.

2. Under Available Templates, do one of the following:

To use a template that we already have installed, click My Templates,
click the template that we want, and then click Create.

To use one of the pre-built templates installed in Publisher, under
Most Popular or More Templates, click the category that we want,
click the template that we want, and then click Create.

To find and apply a template on Office.com, under Most Popular or
More Templates, click the category that we want, click the template
that we want, and then click Download.

Note:

We can also search for templates on Office.com from within Publisher. In the Search
for templates box, type one or more search terms, and then click the arrow button to
search
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7.5.2.1 Creating publication with Installed templates:

We can create any publication easily with the help of the
installed templates available in Publisher. We can use pre
designed templates in publisher and create so many
publications like Brochures, Business Cards, Calendars,
Greeting Cards, Labels, Newsletters, Postcards,
Advertisements, Award Certificates, Banners, Business
Forms, Catalogues,E-mail, Envelops, Flyers, Gift certificates,
Invitation cards, Letterhead, Menus, Resumes and so many
quick publications.

Fig. 7.26

7.7.2.2 Creating publication with online templates:
We can create any publication easily with the help of the internet,
because we have also a option to create publication using online
templates. For online templates, internet facility should be available
in our system.

Fig. 7.27

To find and apply a template on online Templates, click the
category that we want, click the template that we want, and then
click Download, and then apply that template.
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7.8 Saving Your Publication: There are two basic ways to save our
publication.

First one is to Point and click on the save icon on our toolbar.

OR

Follow these steps:

1. Click on the File Menu and Save As.

2. When the Save As Dialogue Box appears Click Browse and find
the location on computer where you want to save the file
saved.

3. Type the name of our publication in the File Name field.

4. Click on the Save button.

7.9 Printing Your Publication: There are two basic ways to print your
publication.

First one is to click on the print icon on toolbar. This will print
one copy of our publication with the default print options.

OR
1. Click on the File Menu and click Print.
2. When the print window appears, select the desired

number of copies.
3. Choose any other Print Settings:

° All Pages, Selection, Current Page, or Custom Range
° Manually enter page numbers we want to print

° How many pages print per sheet of paper

° Paper Size

° 1-sided or 2-sided printing
4. Click Print.

oints emember

1. Publisher is an application used to design and produce attractive
advertising and promotional material

2. A template is the predefined model of publication

Publisher enables us to produce quick publications by using
wizards and a design gallery

4. To open the Microsoft publisher by keyboard, Type “Publisher” in
search bar and press enter button
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10.

11.
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13.

14.
5
16.

17.
18.
19.
20.

21.

22.
23.

24.

25.

We can also add the objects to the blank Layout like text, picture,
word art, and auto shapes etc.

After creating publication, save the publication by clicking on save
option in File Tab

Close the publication by clicking close button in File menu

Before exiting Publisher, we should close all the publications

We can place the quick access toolbar above or below the ribbon

We can also add items to the quick access toolbar, simply click on any
item

The ribbon is the panel at the top portion of the document it has six
tabs

Each tab is divided into groups

To view additional features within each group, click the dialog box
launcher (arrow) at the bottom right corner of each group.

Click and drag the handles to resize
The corner handles will resize the object proportionally

The handles centered on the lines of the box will stretch the object
vertically and horizontally

The green handle allows you to rotate the object
Place our cursor over the solid line so that we see the crosshairs.
Click and drag the object to the desired location

Most publications are divided into several different areas called
frames

When we click on a frame, small circles appear around the edge of the
frame. These are called handles

We can click and drag on the handles to resize our frame.

A Template is a tool used in Publisher to help us easily create basic
publications

In arrange group, the text will be arranged around the object by using
Wrap Text

If we want to delete any objects which are not required in publication,
click on the object and press Delete button from the keyboard.
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Exercise

Multiple Choice Questions:

Choose an application used to design
and produce attractive advertising and
promotional material.

b) Spreadsheet
d) Presentation

a) Document
c) Publication

Publisher enables us to produce quick
publications by using

b) Wizards
d) All of these

To open the Microsoft publisher by
keyboard, what we need to type in
search bar?

a) Manual
c) Customize

a) WordPad b) Notepad
c) Access d) Publisher
Each tab is divided into

a) Groups b) Blocks

c) Menus d) Parts

After creating publication, save the
publication by clicking on save option
in

a) File
c) Insert

b) Home
d) View

Close the publication by clicking
button in File menu.

b) New
d) Close

a) Open
c) Print

Fill in the Blanks:

We can also add the objects to the

blank Layout like ,

word art, and auto shapes etc.

The handles centered on the lines of
the box will stretch the object

and

o

—

We can and on the
handles to resize our frame.

To view additional features within
each group, click the dialog box
launcher (arrow) at the bottom
________ ofeach

When we click on a , small
circles appear around the edge of the
frame. These are called

True or False:

A Template is a tool used in
Publisher to help us easily create
basic publication.

Most publications are divided into
several different areas called
frames.

The corner handles will resize the
object proportionally.

Before exiting Publisher, we should
not close all the publications.

We cannot add items to the quick
access toolbar by click on any item.

Very Short Answer type Questions:

Extension used to save a publication
is?

To move objects which cursor is
used?

Online Templates are available in?
List of our recently used Publisher
files are in?

The text is arranged around the
object by using which option?

Short Answer type Questions:

1. What is Publisher?

2. Write the steps for Moving
Objects in publisher.

3. Define Templates?
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Long Answer type Questions: 2. How to add text using text box
and write the steps for editing

1. How to create a publication
using blank Layout in
publisher?

Answers Key

Publication Text and Picture
Wizards Vert%cally and True
horizontally
Pubhsher Click and drag True
Groups Right corner, group False
File Frame, handles False
Close = -
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crosshairs

Office.com
Recent

Wrap Text



Chapter

8 Microsoft Publisher - 1l

Objectives of this chapter:

8.1 Advertisements

8.2 Business Cards

8.3 Greeting Cards / Invitation Cards / Compliment Cards
8.4 Award Certificates
8.5 Envelops

8.6 Labels

8.7 Letterhead

8.8 Calenders

8.9 Resumes

8.10 Menus

8.11 Signs

8.12 Paper folding projects

8.1 Advertisements:

Advertising means how a company encourages people to buy their
products, services or ideas. An advertisement or "ad" for short is anything that
draws good attention towards these things. It is usually designed by an
advertising agency. Ads appear on television, as well as radio, newspapers,
magazines etc. Advertising is an audio or visual form of marketing
communication that employs an openly sponsored, non-personal message to
promote or sell a product, service or idea. Sponsors of advertising are often
businesses who wish to promote their products or services.

Advertising is communicated through various mass media, including old
media such as newspapers, magazines, Television, Radio, outdoor advertising
or direct mail; or new media such as search results, blogs, websites or text
messages. The actual presentation of the message in a media is referred to as
an advertisement or "ad". Non-commercial advertisers include political
parties, interest groups, religious organizations and governmental agencies.
The following figure shows an example of an advertisement.
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Fig 8.1

MS - Publisher offers templates and other tools to help us to create a variety of
publications, including brochures, newsletters, business cards, and menus.
Various print media used for advertisement are:

8.1.1 Brochures

8.1.2 News letters

8.1.3 Banners

8.1.4 Catalogues

8.1.5 Flyers

8.1.1 Brochure:

A brochure is an informative paper document often used for advertising
that can be folded into a template, pamphlet or leaflet. Brochures are
promotional documents, primarily used to introduce a company, organization,
products or services to the public. Brochures are distributed inside
newspapers, handed out personally or placed in brochure racks in high traffic
locations. They may be considered as grey literature.
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Now day's brochures are also available in electronic format and are called e-
brochures. They have the added benefit of having unlimited distribution and
cost savings when compared to traditional

paper brochures.

The most common types of single-sheet
brochures are the bi-fold (a single sheet
printed on both sides and folded into halves)
and the tri-fold (the same, but folded into
thirds). A bi-fold brochure results in four
panels (two panels on each side), while a tri-
fold results in six panels (three panels on
each side).
Other brochure fold arrangements are
also possible: the accordion or "z-fold"
method, the "c-fold" method, etc. Larger
sheets, such as those with detailed maps or
expansive photo spreads, are folded into )
four, five, or six panels. Fig 8.2
Booklet brochures are made of multiple sheets most often saddle
stitched stapled on the creased edge, or perfect bound like a paperback book,
and result in eight or more panels.
8.1.1.1 Creating Brochures using MS-Publisher:
Steps to create Brochures in Publisher:
1. Click on File Tab, then New, and then Brochures.
There are many Templates related with brochures, which are already available
in Install Templates. Select any one according to our choice. Now, we can see at
right side of window, many options are available for customizing this selected
brochure.

Fig 8.3

27




2. Now, customize your brochure with the help of color scheme, font scheme, page
size options and forms.

Fig 8.4
Color Scheme Font Scheme Page Size
Form
3. After changing of color, fonts, size and forms of brochure, click
on Create option.

Fig 8.5
4. We will see the brochure as shown in figure below.

Fig 8.6
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Now we can edit our brochure's details and save it as publication.
8.1.2 Newsletters:

A newsletter is a printed report containing news or information of the
activities of a business or an organization that is sent by mail regularly to all its
members, customers, employees or people, who are interested in. Newsletters
generally contain one main topic of interest to its recipients. A newsletter may
be considered grey literature.

E-newsletters are delivered electronically via e-mail and can be viewed as
spamming if sent unsolicited.
8.1.2.1 Creating Newsletters using MS-Publisher:
Steps to create Newsletters in Publisher:
1. Click on File Tab, then New, and then Newsletters.

Fig 8.7
2. Select newsletter design from available Templates as per requirement
and click on Create.
Fig 8.8

129




Now we can edit our newsletter's details and save it as a publication.
8.1.3 Banners:

A long strip of cloth bearing a slogan or design carried in a
demonstration, procession or hung in a public place. Depending on how it is
used, a banner can be a flag or other piece of cloth bearing a symbol, logo,
slogan or other marketing message.

An online banner is either a graphic image that announces the name or
identity of a site. An online banner is a typically rectangular advertisement
placed on a Web site's main content and is linked to the advertiser's own Web
site.
8.1.3.1 Creating Banners using MS-Publisher:

Steps to create Newsletters in Publisher:

1. Click on File Tab, then New, and then Banners.

Fig 8.9

2. Select a newsletter design from Available Templates as per requirement,
here we have three categories: Congratulations, Event and Get well.

3. Click on Create button.

Banner will be shown as in figure below:

Fig 8.10

Now we can edit the banner and save it.
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8.1.4 Flyers:

A flyer is a form of paper advertisement used for wide distribution,
posted or distributed in a public place, handed out to individuals or sent
through the mail. Flyers range from inexpensive photocopied leaflets to
expensive, glossy, full-color circulars. Flyers may be used by anyone including
individuals, businesses, not-for-profit organizations or governments for:

a) Advertising an event such as a live concert, nightclub
appearance, festival, or a rally

b) Promotion of a business, discount store or a service business
such as arestaurant or a gym.
c) Persuading people about a social, religious, or political

message, campaign activities on behalf of a political party or
candidate during an election.
d) Recruiting members for organizations or companies.

In Installed Templates, various flyers for different events and
marketing are available in MS publisher. We can choose the flyers as per our
requirement. After that we can edit the basic information to be displayed on
it and save it as a publication. Example of a flyer is shown in the figure
below:

Fig 8.11
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8.2 Business Cards: A small card printed with one's name, occupation,
business address, etc. is called a business card.

Business cards are cards bearing business information about a company
or individual. They are shared during formal introductions. A business card
typically includes the giver's name, company or business affiliation (usually
with a logo) and contact information such as street addresses, telephone
number (s), fax number, e-mail addresses and website. In these days, business
cards may also include social media addresses such as Facebook and Twitter.
Traditionally many cards were simple black text on white stock; today a
professional business card will sometimes include one or more visual design.
8.2.1 Creating Business Card in Publisher:

1. Click on File Tab, then New, and then Business Card.

There are so many Templates available in Install Templates
related with Business Card. Select any one according to your choice.
On right side of window, we can customize the selected Business
Card with the help of color scheme, font scheme, business
information, page size options and logo.

2.  After changing of color, fonts scheme, business information and

page size, click on Create button.

Fig 8.12

3. Now, we will see the Business Card as shown as below figure. The
Business Card is designed successfully. Now we can change Business Name or
Individual name also, Address, Contacts etc.
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Fig 8.13

8.3 Greeting Card/ Invitation card/ compliment card:

A greeting card/ Invitation card/ compliment card is a piece of card of
high quality paper expressing friendship or any other sentiment. Although
these cards are usually given on special occasions such as Birthdays,
Anniversary, Christmas, Diwali or other holidays, they are also sent to convey
thanks or express other feelings. These cards are usually packaged with an
envelope and come in a variety of styles. There are both mass-produced as well
as handmade versions that are distributed by hundreds of companies.

Fig 8.14 Greeting Card Fig 8.15 Invitation Cards

Fig 8.16 Compliment Cards
These can also be designed with the help of MS Publisher.
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8.2 Award Certificates:

An award is something given to a person, a group of people, or an
organization in recognition of their excellence in a certain field. An award may
be accompanied by trophy, title, certificate, medal, badge, pin, or ribbon.

Certification refers to the confirmation of certain characteristics of an
object, person, or organization. This confirmation is often, but not always,
provided by some form of external review, education, assessment, or audit.

Certificates of achievement, merit, and honor can be powerful tools when
used at the right time and presented in the right way. Receiving an award
certificate gives a person the warm glow of knowing someone took the time to
acknowledge them. And being the person who motivates others can be
rewarding, too.

Award certificates may include: Community Service Award, Great Job,
Good Behavior or Course Completion. MS Publisher provides many templates
for creating Award Certificates. Figure shown below is an example of certificate
of Appreciation created using M'S publisher.

Fig 8.17

Various Templates in MS publisher as shown in figure below can be
used to create this certificate.
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Fig 8.18

After selecting the required certificate design, edit the color scheme and click
on Create button. Now we can edit the certificate information and save it as a
publication.

8.5 Envelops:

An envelope is a common packaging item, usually made of thin flat
material. It is a flat paper container with a sealable flap designed to enclose a
flat object, such as a letter, card or document. Traditional envelopes are made
from sheets of paper. They are most commonly used for enclosing and sending
mail (letters) through a prepaid-postage postal system.

Envelop with mailer's address and recipient's address may look like the
figure shown below.

Fig 8.19
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We can create envelop with Various Templates in MS publisher. After selecting
the required envelop design, edit the color scheme and click on Create button.
Now we can edit the envelop information and save it as a publication.

8.6 Labels:

Alabel is a piece of paper, polymer, cloth, metal, or other material affixed
to a container or product. Information printed directly on a container or item
can also be considered labeling. Labels have many uses, including providing
information on a product's origin, manufacturer (e.g., brand name), use, shelf-
life and disposal etc. Many hazardous products such as poisons or flammable
liquids must have a warning label.

Labels can be used for:

° Products: Permanent product labels need to remain secure
throughout the life of the product. For example, a food label must
be secure until the food has been used.

° Packaging: Packaging may have labeling attached to or integral
with the package. These may carry pricing, barcodes, UPC
(Universal Product Code) identification, usage guidance,
addresses, advertising, recipes, and so on.

° Assets: In industrial or military environments, asset labeling is
used to clearly identify assets for maintenance and operational
purposes. Such labels are frequently made of engraved Trifoliate or
a similar material.

° Textiles: Garments normally carry separate care/treatment
labels which typically indicate how the item should be washed for
e.g. machine washed or dry cleaned. Textile labels may be woven
into the garment or attached, and may be heat resistant, colorfast,
washable. Printed labels are an alternative to woven labels.

° Mailing: Mailing labels identify the addressee, the sender and any
other information which may be useful in transit.

) Security labels: They are used for authentication, theft reduction,
and protection against counterfeit and are commonly used on ID
cards, credit cards, packaging, and products from CDs to
electronics to clothing.

Labels may be used for any combination of identification, information,
and warning, instructions for use, environmental advice or advertising. They
may be stickers, permanent or temporary labels or printed packaging.

8.6.1 Creating Labels in Publisher:

Here we are designing a label for a CD/DVD with the help of MS
publisher. Follow the steps written below:

1. Click on File Tab, then New, and then Labels.

2. In category Media, select All Media. Here select the CD/DVD

Labels. Select required template, edit the color scheme and click
on Create button.
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Fig 8.20

3. Here we can edit the information related CD/DVD which is to be
shown on the label

Fig 8.21

4. Save the label as a publication for future use. We can print these
labels as per our requirement.
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8.7 Letterhead:

It is stationery with a printed heading. The heading usually consists of a
name and an address, a logo or corporate design, and sometimes a background
pattern. The term "letterhead" is often used to refer to the whole sheet imprinted
with such a heading. Many companies and individuals prefer to create a
letterhead template in a word processor or other software application. This
generally includes the same information as pre-printed stationery, but at lower
cost. Letterhead can then be printed on stationery or plain paper as needed or
sent electronically.

8.7.1 Creating Letterhead in Publisher:

Here we are creating a Letterhead for an organization using MS publisher.
Follow the steps written below:
1. Click on File Tab, then New, and then Letterhead.
There are many Templates are available in Install Templates related with
Letterhead. Select any one according to our choice. On right side of window, we
can customize color scheme, font scheme, business information and logo.

Fig 8.22
1. After changing of color, fonts, size and other information, click on
Create option. The letterhead will be shown.
2. Now edit the necessary information as we can see in the figure

below and save the changes.
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Fig 8.23

8.8 Calendar:

A calendar is a system of organizing days for social, religious, commercial or
administrative purposes. This is done by giving names to periods of time, typically
days, weeks, months and years. Calendars are also used to help people manage
their personal schedules, time and activities.

Calendars are also used as part of a complete timekeeping system: date
and time of day together to specify a moment in time.

8.8.1 Creating Calendars in MS Publisher:

To create Calendar in Publisher, follow these steps:

1. Click on File Tab, then New, and then Calendars.

From the Templates related to Calendars, available in install Templates,
select any one according to our choice. Now, we can see at right side of window,
there are many options available for customizing this selected Calendars.

Fig 8.24
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2. Now, customize our calendar with the help of color scheme, font scheme,
Business information, page size options and specially Timeframe (One
month per page or One year per page).

3. After customizing Calendars, click on Create option.

4. Now, we will see the Calendar as shown in figure below. If we want, we
can edit the picture also and can save this calender in publisher.

Fig 8.25

8.9 Resumes:

A resume provides a summary of our education, work history,
credentials, and other accomplishments and skills. There are also optional
sections, including a resume objective and career summary statement.
Resumes are the most common document requested of applicants in job
applications. A resume should be as concise as possible. Typically, a resume is
one page long, although sometimes it can be as long as two pages. Often
resumes include bulleted lists to keep information concise.

8.9.1 Creating Resumes in MS Publisher:
To create Resumes in Publisher, follow these steps:

1. Click on File Tab, then New, and then Resumes.
From the Templates related to Resumes, available in install
Templates, select any one according to our choice. After customizing
the selected Resume click on Create button.
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Fig 8.26

2. Now edit the necessary information in our resume and save the
changes. The resume will be as figure shown below.

Fig 8.27




8.9.2 Curriculum vitae(CV):

Like resume, a curriculum vitaE (CV) provides a summary of one's
experience and skills. Typically, CVs are longer than resumes - at least two or
three pages. CVs include information on one's academic background,
including teaching experience, degrees, research, awards, publications,
presentations, and other achievements. CVs are thus much longer than
resumes, and include more information, particularly related to academic
background.

We can create CVs with the help of MS Publisher in same way we have
created Resumes above.

8.10 Menus:

In a restaurant, there is a menu of food and beverage offerings. A menu
may be a list from which guests use to choose options available. Basically Menu
is the main way to give or take order from guest. Guest may order properly to
see the menu and be aware about our food and price. MS Publisher provides
many templates for creating a Menu. Below figure shows the example Menu
designed in M'S Publisher.

Fig 8.28
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8.11 Signs:

A sign is a piece of paper, clothe, wood or any other material which is
painted with pictures or words and which gives some information about a
particular place, product, or event. MS Publisher provides us with many of
these signs as shown in figure below. We can create any of these sign using
publisher.

Fig 8.29

8.12 Paper Folding Projects:
The paper folding templates include patterns for paper airplanes and

origami projects alike. They include pages (that may require trimming) with "fold-
lines" and others with instructions to create our paper masterpieces. @We can
enjoy these Paper Folding Projects in our leisure time and can make some creative
things.

Microsoft Publisher offers templates for kids. These templates consist of
different paper folding projects like airplanes, boats, cups, and more.
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10.

11.

1125

13.

oints emember

Advertising means how a company encourages people to buy
their products, services or ideas.

MS - Publisher offers templates and other tools to help us
create a variety of publications, including brochures,
newsletters, business cards, and menus.

Brochures are promotional documents, primarily used to
introduce a company, organization, products or services to the
public.

Now day's brochures are also available in electronic format
and are called e-brochures

A newsletter is a printed report containing news or information
of the activities of a business or an organization.

A long strip of cloth bearing a slogan or design carried in a
demonstration, procession or hung in a public place.

A flyer is a form of paper advertisement used for wide
distribution, posted or distributed in a public place, handed
out to individuals or sent through the mail.

Business Cards: A small card printed with one's name,
occupation, business address, etc. is called a business card.
Business cards are cards bearing business information about
a company or individual

A greeting card/ Invitation card/ compliment card is a piece of
card or high quality paper expressing friendship or any other
sentiment.

An award is something given to a person, a group of people, or
an organization in recognition of their excellence in a certain
field. An award may be accompanied by trophy, title,
certificate, medal, badge, pin, or ribbon.

Certificates of achievement, merit, and honor can be powerful
tools when used at the right time and presented in the right
way.

An envelope is a common packaging item, usually made of thin
flat material. It is a flat paper container with a sealable flap
designed to enclose a flat object, such as a letter, card or
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14.
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16.

17.

18.

KO

20.

21.

22.

23.

document. Traditional envelopes are made from sheets of
paper. They are most commonly used for enclosing and
sending mail (letters) through a prepaid-postage postal system
A label is a piece of paper, polymer, cloth, metal, or other
material affixed to a container or product.

It is stationery with a printed heading. The heading usually
consists of a name and an address, a logo or corporate design,
and sometimes a background pattern.

A calendar is a system of organizing days for social, religious,
commercial or administrative purposes. This is done by giving
names to periods of time, typically days, weeks, months and
years.

A resume provides a summary of our education, work history,
credentials, and other accomplishments and skills. There are
also optional sections, including a resume objective and career
summary statement.

Resumes are the most common document requested of
applicants in job applications. A resume should be as concise
as possible.

A curriculum vita (CV) provides a summary of one's experience
and skills. Typically, CVs are longer than resumes - at least
two or three pages. CVs include information on one's
academic background, including teaching experience, degrees,
research, awards, publications, presentations, and other
achievements.

Menu is the main way to give or take order from guest. Guest
may order properly to see the menu and be aware about our
food and price.

A sign is a piece of paper, cloth, wood or any other material
which is painted with pictures or words and which gives some
information about a particular place, product, or event.

We can enjoy these Paper Folding Projects in our leisure time
and can make some creative things.

Microsoft Publisher offers templates for kids. These templates
consist of different paper folding projects like airplanes, boats,
cups, and more.
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1.

Exercise 2.

Multiple Choice Questions:

Now day's brochures are also available 3.

in electronic format and are

a) e-brochures b) m-brochures
c) t-brochures d) k-brochures

A small card printed with one's 4.

name, occupation, business address,
etc.is called.................

a) Brochures
c) Business cards d) Menus

What is the most common document

requested of applicants in job
applications?

a) Banner b) Resume

c) Calendar d) Flyer 2.

What are longer than resumes - at
least two or three pages?

a)Curriculum vita (CV) 3.
b) Banner
c) Invitation
d) Catalogue
Fill in the Blanks: 4.

Advertising means how a company
encourages people to buy their.........
.or ideas.

MS - Publisher offers templates and
other tools to help us create a variety
of publications, including brochures,
newsletters, ........ ,and ...
Business cards are cards bearing
business information abouta ............

A resume provides a summary of our

.............. credentials, and

other accomplishments and skills.
True or False:

A compliment card is a piece of card or
high quality paper expressing
friendship or any other sentiment.

‘A fant, mifgeraaT w3 uie farest fegmar uamg|
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b) Newsletters 1.

Ol O = 0l

Certificates of achievement,
merit, and honor can be powerful
tools.

Brochures are promotional
documents, primarily never used
to introduce a company,
organization,

Very Short Answer type
Questions:

What is a piece of paper, cloth,
wood or any other material which
is painted with pictures or words
and which gives some
information about a particular
place, product, or event

What is a common packaging
item, usually made of thin flat
material?

What is something given to a
person, a group of people, or an
organization in recognition of
their excellence in a certain field?
What is a form of paper
advertisement used for wide
distribution, posted or distributed in
a public place, handed out to
individuals or sent through the
mail?

What is a printed report
containing news or information
of the activities of a business or
an organization

Short Answer type Questions:

Explain Signs?
Explain Resumes?
Whatis Banner?
Explain Newsletters?
What are Menus?



6. Long Answer type Questions:

steps for creating Business Card

Letterhead? How to

in Publisher?
1. What are Advertisements? Explain 3. What is Label? Where labels can
various print media used for be used for?
advertisements? 4, What
2. What are Business Cards? Write

Answers Key

e-brochures Products and services
B
Business cards usiness cards and True
menus
Company and
R .. Fals
esume Individual anse
Curriculum vita Education and work
CV) History
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create Letterhead in Publisher?

T
m Multiple Choice Fill in the Blanks Very Short Answer

Envelope
Award

Flyer

Newsletter






